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Safety warning notice

Å
WARNING: To reduce the possibility of heat-related injuries or of overheating the computer, do not place the computer directly 
on your lap or obstruct the computer air vents. Use the computer only on a hard, flat surface. Do not allow another hard surface, 
such as an adjoining optional printer, or a soft surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow 
the AC adapter to contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the 
AC adapter comply with the user-accessible surface temperature limits defined by the International Standard for Safety of 
Information Technology Equipment (IEC 60950).
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1
Product description

Category Description PM45 chipset GM45 chipset GL40 chipset

Product name HP ProBook 4310s 
Notebook PC

HP ProBook 4311s 
Notebook PC
(People’s Republic of China only)

Processors Intel® Core™2 Duo processors:

■ T9600 2.80-GHz processor, 
6-MB L2 cache, 1066-MHz 
front side bus (FSB)

■ P8700 2.53-GHz processor, 
3-MB L2 cache, 
1066-MHz FSB

■ P7370 2.00-GHz processor, 
3-MB L2 cache, 
1066-MHz FSB

■ T6570 2.10-GHz processor, 
2-MB L2 cache, 800-MHz FSB 
(not available in Japan)

■ Intel Core Duo T5870 2.00-GHz 
processor, 2-MB L2 cache, 
800-MHz FSB (not available 
in Japan)

Intel Dual Core 
Celeron® processors:

■ T1700 1.83-GHz processor, 
1-MB L2 cache, 667-MHz FSB

■ T1600 1.66-GHz processor, 
1-MB L2 cache, 667-MHz FSB

Intel Celeron 585 2.16-GHz 
processor, 2-MB L2 cache, 
800-MHz FSB

(Continued)
Maintenance and Service Guide 1–1



Product description
Chipset Northbridge:

■ Intel PM45 with up to 
1066-MHz FSB

■ Intel GM45 with up to 
1066-MHz FSB

■ Intel GL40 with up to 
667-MHz FSB

Southbridge: Intel ICH-9M

Graphics AMD M92S2-LP (ATI Mobility 
Radeon™ HD 4330) discrete 
graphics with Hypermemory 
support, 512 MB GDDR2
(64 MB × 16 × 2) at 500-MHz

Intel UMA graphics (Mobile Intel 
GMA X4500 HD) Integrated with 
shared video memory 
(dynamically allocated)

Panel ■ 13.3-in, high-definition 
(HD, 1366 × 768), AntiGlare, 
LED display assembly

■ 13.3-in, HD (1366 × 768), 
BrightView, LED 
display assembly

■ 13.3-in, HD (1280 × 720), 
720P BrightView, 
LED display assembly

■ Supports privacy filter

(Continued)
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Product description
Memory 2 customer-accessible/upgradable 
memory module slots
Supports dual-channel memory
Supports the following DDR3 
configurations at 1333 MHz in all 
countries and regions 
except Brazil:

■ 8192-MB total system memory 
(4096 × 2, dual-channel)

■ 6144-MB total system memory 
(4096 + 2048, dual-channel)

■ 5120-MB total system memory 
(4096 + 1024, dual-channel)

■ 4096-MB total system memory 
(4096 × 1)

■ 4096-MB total system memory 
(2048 × 2, dual-channel)

■ 3072-MB total system memory 
(2048 + 1024, dual-channel)

■ 2048-MB total system memory 
(1024 × 2, dual-channel)

■ 2048-MB total system memory 
(2048 × 1)

■ 1024-MB total system memory 
(1024 × 1)

Supports the following DDR3 
configurations at 1333 MHz 
in Brazil:

■ 3072-MB total system memory 
(2048 + 1024, dual-channel)

■ 2048-MB total system memory 
(1024 × 2, dual-channel)

■ 2048-MB total system memory 
(2048 × 1)

■ 1024-MB total system memory 
(1024 × 1)

(Continued)
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Product description
Hard drives Supports 9.50-mm, 6.35-cm 
(2.50-in) hard drives
Supports HP 3D DriveGuard 
Hard Drive Protection
Customer-accessible
Serial ATA (SATA)
Supports the following hard 
drives:

■ 500-GB, 7200- and 5400-rpm

■ 320-GB, 7200- and 5400-rpm

■ 250-GB, 7200-rpm

■ 160-GB, 7200-rpm

Optical drives 12.7-mm tray load
Serial ATA (SATA)
Fixed (removal of 1 screw 
required)
Customer-accessible
Supports no-optical-drive option

Supports the following drives: 

■ Blu-ray ROM DVD±R/RW and 
CD-RW SuperMulti 
Double-Layer Drive with 
LightScribe

■ DVD±RW and CD-RW 
SuperMulti Double-Layer Drive 
with LightScribe

■ 8X DVD-ROM Drive

Diskette drive Supports external USB drive only
Supports boot from USB device

Microphone Integrated dual-array digital 
microphone 

(Continued)
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Product description
Audio 2 stereo speakers with enclosures
Azalea ADI1984 CODEC with 
digital equalization
Headphone jack
Microphone jack

Webcam Integrated 2-megapixel camera 
with fixed focus

Modem High-speed 56K data/fax modem
Supports no-modem option
Modem module cable not included

Ethernet Marvell 88E8072-B1 10/100/1000 
network interface card (NIC)
S3/S4/S5 wake on LAN 
(AC mode only)
Ethernet cable not included

Wireless Integrated wireless local-area 
network (WLAN) options via 
Mini PCI module:

■ Broadcom 4322AGN 
802.11b/g/n WLAN module

■ Broadcom 4312G 802.11b/g 
WLAN module

■ Intel WiFi Link 5100 
802.11b/g/n WLAN module

■ Intel WiFi Link 5100 802.11b/g 
WLAN module

Supports no-WLAN option
2 WLAN antennas built into the 
display assembly

Integrated wireless wide-area 
network (WWAN) options via 
Mini PCI module:

■ High-speed packet access 
(HSPA), evolution-data 
optimized (EV-DO) WWAN 
module

■ Telecom EV-DO CT1 WWAN 
module

■ Telecom EV-DO CT2 WWAN 
module

WWAN security provided by 
subscriber identity module (SIM), 
user-accessible behind battery
2 WWAN antennas (worldwide, 
5-band) built into the 
display assembly
Does not support WWAN 
aftermarket option

Integrated wireless personal area 
network (WPAN) options via 
Bluetooth® module

(Continued)
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Product description
External media 
cards

One ExpressCard slot, supporting 
optional ExpressCard/34 cards
SD Card Reader supporting the 
following optional digital card 
formats:

■ MultiMediaCard

■ MultiMediaCard Plus

■ Secure Digital Memory Card

■ Secure Digital High Capacity 
Memory Card

Ports Audio-in (stereo microphone)
Audio-out (stereo headphone)
HDMI v.1.3
Multi-pin AC power
RJ-45 (Ethernet, includes link and 
activity lights)
RJ-11 (modem)
USB v. 2.0 (3)
VGA (Dsub 15-pin) supporting 
1600 × 1200 external resolution at 
75 GHz

Keyboard/
pointing devices

Spill-resistant keyboard
TouchPad with TouchPad buttons
Touch-sensitive controls
Supports 2-way scroll with legend
Taps enabled by default 

Power 
requirements

90-W AC adapter for use only on 
computer models equipped with a 
graphics subsystem with 
discrete memory

65-W AC adapter for use only on 
computer models equipped with a 
graphics subsystem with 
UMA memory

Supports multipin AC connector 
and 3-wire plug (with ground pin)

Battery options:

■ 8-cell, 2.55-Ah (73-Wh) 
Li-ion battery

■ 6-cell, 2.20-Ah (37-Wh) 
Li-ion battery

Security Security cable slot
Integrated fingerprint reader

(Continued)
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Product description
Operating system Preinstalled:

■ Free DOS

■ Red Flag Linux (People’s 
Republic of China only)

■ Windows Vista® Business 32

■ Windows Vista Business with 
Windows® XP Pro image

■ Windows Vista Home Basic

■ Windows Vista Home 
Premium 32

Preinstalled with 
Microsoft® Office:

■ Windows Vista Home Basic 32 
with Office 2007 Ready

■ Windows Vista Home Basic 32 
with Office 2007 Personal
(Japan only)

■ Windows Vista Home Basic 32 
with Office 2007 Personal with 
PowerPoint (Japan only)

■ Windows Vista Home 
Premium 32 with Office 
2007 Ready

■ Windows Vista Business 32 
with Office 2007 Ready

■ Windows Vista Business 32 
with Office 2007 Personal
(Japan only)

■ Windows Vista Business 32 
with Office 2007 Personal with 
PowerPoint (Japan only)

■ Windows Vista Business 32 
(with XP Pro images) with 
Office 2007 Ready

■ Windows Vista Business 32 
(with XP Pro images) with 
Office 2007 Personal 
(Japan only)

■ Windows Vista Business 32 
(with XP Pro images) with 
Office 2007 Personal with 
PowerPoint (Japan only)

(Continued)
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Product description
Operating system 
(continued)

Restore media:

■ DRDVD Windows Vista

■ DRDVD Windows XP Pro

■ Microsoft Office Ready DVD

■ Red Flag Linux (People’s 
Republic of China only)

■ Windows Vista Business 32

■ Windows Vista Business 64

■ Windows Vista Home Basic 32

■ Windows Vista Home Premium

■ Windows XP Pro

Certified:

■ Microsoft WHQL

■ SuSE Linux

Web-only support: 
Windows Vista Business 64

Serviceability End-user replaceable parts:
AC adapter
Battery (system)
Hard drive
Keyboard
Memory modules
Optical drive
SIM
WLAN module
WWAN module

Category Description PM45 chipset GM45 chipset GL40 chipset
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External component identification

Display

✎ Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Internal display switch Turns off the display if the display is closed while the power is on.

(2) WWAN antennas (2)* Send and receive wireless signals to communicate with wireless wide-area 
networks (WWAN).

(3) Internal microphones (2) Record sound.

(4) WLAN antennas (2)* Send and receive wireless signals to communicate with wireless local area 
networks (WLAN).

(5) Webcam light (select models only) On: The webcam is in use.

(6) Webcam (select models only) Records audio and video and captures still photographs.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around 
the antennas free from obstructions.
To see wireless regulation notices, refer to the section of the Regulatory, Safety and Environmental Notices that applies to your 
country or region. These notices are located in Help and Support.
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External component identification
Top components

Buttons and fingerprint reader

Item Component Description

(1) Speakers (2) Produce sound.

(2) Info Center/QuickLook button Launches Info Center or QuickLook.

(3) Wireless button Turns the wireless feature on or off but does not establish a 
wireless connection.

✎ You must set up or access a wireless network to establish a 
wireless connection.

(4) Volume mute button Mutes and restores speaker sound.

(5) Volume scroll zone Adjusts speaker volume. Slide your finger to the left to decrease volume and 
to the right to increase volume. You can also press the left side of the volume 
slider to decrease volume, or press the right side of the volume slider to 
increase volume.

(Continued)
2–2 Maintenance and Service Guide



External component identification
(6) Power button ■ When the computer is off, press the button to turn on the computer.

■ When the computer is on, press the button to shut down the computer.

■ When the computer is in the Sleep state (Standby in Windows XP), 
press the button briefly to exit Sleep (Standby).

■ When the computer is in Hibernation, press the button briefly to 
exit Hibernation.

If the computer has stopped responding and Windows shutdown procedures 
are ineffective, press and hold the power button for at least 5 seconds to turn 
off the computer.
To learn more about your power settings:

■ In Windows Vista: Select Start > Control Panel > System and 
Maintenance > Power Options.

■ In Windows XP: Select Start > Control Panel > Performance and 
Maintenance > Power Options.

(7) Fingerprint reader
(select models only)

Allows a fingerprint logon to Windows instead of a password logon.

Item Component Description
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External component identification
Keys

✎ Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) esc key Displays system information when pressed in combination with the fn key.

(2) fn key Executes frequently used system functions when pressed in combination with 
a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in combination with 
the fn key.
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External component identification
Lights

✎ Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) Caps lock light On: Caps lock is on.

(2) Info Center/QuickLook light ■ On: The computer is on.

■ Blinking (5 times):

❐ When the computer is on, press the button to launch Info Center.

❐ When the computer is off or in Hibernation, press the button to launch 
QuickLook.

■ Off: The computer is off or in the Sleep (Standby in Windows XP) or 
Hibernation state.

(3) Wireless light ■ Blue: An integrated wireless device, such as a WLAN device and/or a 
Bluetooth device, is on.

■ Amber: All wireless devices are off.

(4) Volume mute light ■ Turquoise: Computer sound is on.

■ Amber: Computer sound is off.

(5) Volume down light Blinking: The volume scroll zone is being used to decrease speaker volume.

(6) Volume up light Blinking: The volume scroll zone is being used to increase speaker volume.

(7) Power light ■ On: The computer is on.

■ Blinking: The computer is in the Sleep state (Standby in Windows XP).

■ Off: The computer is off or in Hibernation.
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External component identification
Pointing devices

Item Component Description

(1) TouchPad* Moves the pointer and selects or activates items on the screen.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) TouchPad scroll zone Scrolls up or down.

(4) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences:

■ For Windows Vista: Select Start > Control Panel > Hardware and Sound > Mouse.

■ For Windows XP: Select Start > Control Panel > Printers and Other Hardware > Mouse.
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External component identification
Front components

Item Component Description

(1) Drive light ■ Blinking turquoise: The hard drive or optical drive is being accessed.

■ Amber: HP 3D DriveGuard has temporarily parked the hard drive.

(2) SD Card Reader Supports the following optional digital card formats:

■ MultiMediaCard

■ MultiMediaCard Plus

■ Secure Digital Memory Card

■ Secure Digital High Capacity Memory Card

(3) Audio-out (headphone) jack Produces sound when connected to optional powered stereo speakers, 
headphones, ear buds, a headset, or television audio.

✎ When a device is connected to the headphone jack, the computer 
speakers are disabled.

(4) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array 
microphone, or monaural microphone.
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External component identification
Right-side components

Item Component Description

(1) ExpressCard slot Supports optional ExpressCards.

(2) USB port Connects an optional USB device.

(3) HDMI port Connects an optional HDMI device.

(4) External monitor port Connects an external VGA monitor or projector.

(5) Vent Enables airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

(6) RJ-45 (network) jack Connects a network cable.

(7) Security cable slot Attaches an optional security cable to the computer.

✎ The security cable is designed to act as a deterrent, but it may not 
prevent the computer from being mishandled or stolen.
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External component identification
Left-side components

Item Component Description

(1) Battery light ■ Amber: A battery is charging.

■ Turquoise: A battery is close to full charge capacity.

■ Blinking amber: A battery that is the only available power source has 
reached a low battery level. When the battery reaches a critical battery 
level, the battery light begins blinking rapidly.

■ Off: If the computer is plugged into an external power source, the light turns 
off when all batteries in the computer are fully charged. If the computer is 
not plugged into an external power source, the light stays off until the 
battery reaches a low battery level.

(2) Power connector Connects an AC adapter.

(3) Optical drive (select models only) Reads optical discs and, on select models, also writes to optical discs.

(4) RJ-11 (modem) jack
(select models only)

Connects a modem cable.

(5) USB ports (2) Connect optional USB devices.
Maintenance and Service Guide 2–9



External component identification
Bottom components

Item Component Description

(1) SIM slot (select models only) Contains a wireless subscriber identity module (SIM). The SIM slot is located 
inside the battery bay.

(2) Hard drive bay Holds the hard drive and a Bluetooth device.

(3) Memory module compartment Contains the memory module slots and a wireless LAN module slot.

Ä To prevent an unresponsive system and the display of a warning 
message, replace the WLAN module with only a module authorized for 
use in the computer by the governmental agency that regulates 
wireless devices in your country or region. If you replace the module 
and then receive a warning message, remove the module to restore 
computer functionality, and then contact technical support through Help 
and Support.

(4) Vents (3) Enable airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

(5) Battery release latch Releases the battery from the battery bay.

(6) Battery bay Holds the battery.
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Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model number provided on 
the service tag.

Item Component Description

(1) Product name This is the product name affixed to the front of the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n) This number provides specific information about the product’s 
hardware components. The part number helps a service 
technician determine what components and parts are needed.

(4) Model description This is the alphanumeric identifier used to locate documents, 
drivers, and support for the computer.

(5) Warranty period This number describes the duration of the warranty period for 
the computer.
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Computer major components
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Illustrated parts catalog
Item Description Spare part number

(1) 13.3-in, LED, HD display assembly (includes 2 WLAN antenna transceivers and cables, nameplate, and logo):

■ AntiGlare display assembly with webcam and 2 WWAN antennas in black trim 577173-001

■ AntiGlare display assembly with webcam and 2 WWAN antennas in red trim 577182-001

■ AntiGlare display assembly with webcam in black trim 577174-001

■ AntiGlare display assembly with webcam in red trim 577183-001

■ AntiGlare display assembly without webcam in black trim 577172-001

■ AntiGlare display assembly without webcam in red trim 577181-001

■ 1366 × 768 BrightView display assembly with webcam and 2 WWAN antennas in 
black trim

577176-001

■ 1366 × 768 BrightView display assembly with webcam and 2 WWAN antennas in red trim 577185-001

■ 1366 × 768 BrightView display assembly with webcam in black trim 577175-001

■ 1366 × 768 BrightView display assembly with webcam in red trim 577184-001

■ 1366 × 768 BrightView display assembly without webcam in black trim 577177-001

■ 1366 × 768 BrightView display assembly without webcam in red trim 577186-001

■ 1280 × 720 BrightView display assembly with webcam and 2 WWAN antennas in 
black trim

583090-001

■ 1280 × 720 BrightView display assembly with webcam and 2 WWAN antennas in red trim 583091-001

■ 1280 × 720 BrightView display assembly with webcam in black trim 577179-001

■ 1280 × 720 BrightView display assembly with webcam in red trim 577188-001

■ 1280 × 720 BrightView display assembly without webcam in black trim 577178-001

■ 1280 × 720 BrightView display assembly without webcam in red trim 577187-001

✎ See “Display assembly subcomponents” on page 3-10 for display assembly internal component spare 
part information.

(2) Switch cover (includes LED board and cable):

■ In black trim 577207-001

■ In red trim 577208-001

(3) Speakers (include cables) 577215-001

(4) Keyboard (includes keyboard cable):

■ For use in Belgium 577205-A41

■ For use in Brazil 577205-201

■ For use in Bulgaria 577205-261

■ For use in the Czech Republic 577205-221

■ For use in Denmark 577205-081

■ For use in France 577205-051

■ For use in French Canada 577205-121

■ For use in Germany 577205-041

■ For use in Greece 577205-DJ1

■ For use in Hungary 577205-211

(Continued)
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Illustrated parts catalog
(4) Keyboard (continued):

■ For use in Iceland 577205-DD1

■ For use in Israel 577205-BB1

■ For use in Italy 577205-061

■ For use in Japan 577205-291

■ For use in Latin America 577205-161

■ For use in the Netherlands 577205-B31

■ For use in Norway 577205-091

■ For use in Portugal 577205-131

■ For use in Russia 577205-251

■ For use in Saudi Arabia 577205-171

■ For use in Slovakia 577205-231

■ For use in Slovenia 577205-BA1

■ For use in South Korea 577205-AD1

■ For use in Spain 577205-071

■ For use in Sweden and Finland 577205-B71

■ For use in Switzerland 577205-BG1

■ For use in Taiwan 577205-AB1

■ For use in Thailand 577205-281

■ For use in Turkey 577205-141

■ For use in the United Kingdom 577205-031

■ For use in the United States 577205-001

(5a) Palm rest (included with top cover spare part kit)

(5b) Top cover (includes palm rest, TouchPad button board and cable, and TouchPad board and cable):

■ For use only on computer models equipped with fingerprint reader in black trim (includes 
fingerprint reader board and cable)

577216-001

■ For use only on computer models equipped with fingerprint reader in red trim (includes 
fingerprint reader board and cable)

577218-001

■ For use only on computer models not equipped with fingerprint reader in black trim 577217-001

■ For use only on computer models not equipped with fingerprint reader in red trim 577219-001

(6) Bluetooth module 537921-001

✎ The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth module cable is 
included in the Cable Kit, spare part number 577214-001.

Plastics Kit, includes: 577211-001

(7a) ExpressCard slot bezel

(7b) SD Card Reader slot bezel

(7c) Hard drive cover

(7d) Memory/wireless module compartment cover

✎ See “Plastics Kit” on page 3-12 for more Plastics Kit spare part information.

(Continued)
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Illustrated parts catalog
Cable Kit, includes: 577214-001

(8a) Modem module cable (includes RJ-11 connector)

(8b) Bluetooth module cable

(8c) Power connector cable

(8d) Network cable (includes RJ-45 connector)

✎ See “Cable Kit” on page 3-9 for more Cable Kit spare part information.

(9) USB board (includes cable) 577659-001

(10) Modem module:

✎ The modem module spare part kit does not include a modem module cable. The modem module cable is 
included in the Cable Kit, spare part number 577214-001.

■ For use in all countries and regions except Australia and New Zealand 510100-001

■ For use only in Australia and New Zealand 510100-011

(11) Power button board (includes two cables):

■ For use only on computer models equipped with WWAN capability (includes SIM slot) 577662-001

■ For use only on computer models not equipped with WWAN capability 577661-001

(12) System board (includes replacement thermal material):

PM45 system board for use only on computer models equipped with graphics subsystems with discrete memory:

■ For use only on computer models equipped with WWAN capability 577223-001

■ For use only on computer models not equipped with WWAN capability 577222-001

GM45 system board for use only on computer models equipped with graphics subsystems with UMA memory:

■ For use only on computer models equipped with WWAN capability 577225-001

■ For use only on computer models not equipped with WWAN capability 577224-001

GL40 system board for use only on computer models equipped with graphics subsystems with UMA memory:

■ For use only on computer models equipped with WWAN capability 577221-001

■ For use only on computer models not equipped with WWAN capability 577220-001

(13) RTC battery 581926-001

(Continued)
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Illustrated parts catalog
(14) Processor (includes replacement thermal material):

Intel Core2 Duo processors:

■ T9600 2.80-GHz processor, 6-MB L2 cache, 1066-MHz FSB 507955-002

■ P8700 2.53-GHz processor, 3-MB L2 cache, 1066-MHz FSB 507960-001

■ P7570 2.26-GHz processor, 3-MB L2 cache, 1066-MHz FSB 572930-001

■ P7370 2.00-GHz processor, 3-MB L2 cache, 1066-MHz FSB 507966-001

Intel Core Duo processors:

■ T6570 2.10-GHz processor, 2-MB L2 cache, 800-MHz FSB (not available in Japan) 513598-001

■ T5870 2.00-GHz processor, 2-MB L2 cache, 800-MHz FSB (not available in Japan) 535835-001

■ T4200 2.00-GHz processor, 1-MB L2 cache, 800-MHz FSB 513599-001

■ T3100 1.90-GHz processor, 1-MB L2 cache, 800-MHz FSB 572925-001

■ T3000 1.80-GHz processor, 1-MB L2 cache, 800-MHz FSB 572926-001

(15) Fan (includes replacement thermal material) 577206-001

(16) Heat sink (includes replacement thermal material):

■ For use only on computer models equipped with a graphics subsystem with 
discrete memory

577227-001

■ For use only on computer models equipped with a graphics subsystem with 
UMA memory

577226-001

(17) Optical drive (includes bezel and bracket):

■ Blu-ray ROM DVD±R/RW SuperMulti Double-Layer Drive with LightScribe 577202-001

■ DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe 577204-001

■ DVD-ROM Drive 577203-001

(18) Base enclosure (includes 5 rubber feet) 577209-001

Rubber Feet Kit (not illustrated, includes 5 rubber feet and 8 display bezel screw covers) 577212-001

(19) Battery:

■ 8-cell, 2.55-Ah (73-Wh) Li-ion battery 579320-001

■ 6-cell, 2.20-Ah (37-Wh) Li-ion battery 579319-001

(20) Hard drive (includes hard drive connector and hard drive bracket):

■ 500-GB, 7200-rpm 579213-001

■ 500-GB, 5400-rpm 577201-001

■ 320-GB, 7200-rpm 579212-001

■ 320-GB, 5400-rpm 577200-001

■ 250-GB, 7200-rpm 577199-001

■ 160-GB, 7200-rpm 577198-001

(21) Memory modules (1333-MHz, DDR2):

■ 2048-MB 577197-001

■ 1024-MB 577196-001

(Continued)
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Illustrated parts catalog
(22) WLAN module:

802.11b/g/n WLAN module:

■ Intel WiFi Link 5100 802.11b/g/n WLAN module for use in all countries and regions 
except Pakistan, Russia, and the Ukraine

480985-001

■ Broadcom 4322AGN 802.11b/g/n WLAN module for use in Canada, the Cayman Islands, 
Guam, Puerto Rico, the United States, and the U.S. Virgin Islands

504664-001

■ Broadcom 4322AGN 802.11b/g/n WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, 
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, 
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British 
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape 
Verde, the Central African Republic, Chad, Colombia, Comoros, the Congo, Costa Rica, 
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican 
Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, 
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, 
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, 
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, 
Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, 
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the 
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, 
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether 
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, 
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of China, 
Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, 
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, 
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon 
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. 
Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, 
Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, 
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United 
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, 
and Zimbabwe

504664-002

Intel WiFi Link 5100 802.11b/g WLAN module for use only in Pakistan, Russia, and 
the Ukraine

482957-001

(Continued)

Item Description Spare part number
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(22) WLAN module (continued):

802.11b/g WLAN module:

■ Broadcom 4312G 802.11b/g WLAN module for use in Canada, the Cayman Islands, 
Guam, Puerto Rico, the United States, and the U.S. Virgin Islands

504593-003

■ Broadcom 4312G 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, 
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, 
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, 
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, 
Cameroon, Cape Verde, the Central African Republic, Chad, Colombia, Comoros, 
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, 
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, 
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, 
Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, 
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, 
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, 
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, 
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, 
the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, 
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, 
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, 
Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, 
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, 
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

(23) WWAN module:

■ HSPA EV-DO WWAN module for use in all countries and regions except 
the People’s Republic of China

483377-002

■ Telecom EV-DO CT1 WWAN module for use only in the People’s Republic of China 574246-001

■ Telecom EV-DO CT2 WWAN module for use only in the People’s Republic of China 582724-001

Item Description Spare part number
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Cable Kit

Item Description Spare part number

Cable Kit: 577214-001

(1) Bluetooth module cable

(2) Modem module cable (includes RJ-11 connector)

(3) Power connector cable

(4) Network cable (includes RJ-45 connector)
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Display assembly subcomponents
3–10 Maintenance and Service Guide



Illustrated parts catalog
Item Description Spare part number

(1) Display bezel:

■ For use only on computer models equipped with a webcam 577194-001

■ For use only on computer models not equipped with a webcam 577195-001

(2) Webcam module 577171-001

(3) Display hinges (2) 577191-001

(4) Display panel cable:

■ For use only on computer models equipped with a webcam 577663-001

■ For use only on computer models not equipped with a webcam 577190-001

Display Cable Kit:

(5a) ■ For use only on computer models equipped with WWAN capability (includes WLAN and 
WWAN antenna transceivers and cables, and microphones and cables)

577228-001

(5b) ■ For use only on computer models not equipped with WWAN capability (includes WLAN 
antenna transceivers and cables, and microphones and cables)

578365-001

(6) Display enclosure:

■ In black trim 577192-001

■ In red trim 577193-001
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Plastics Kit

Item Description Spare part number

Plastics Kit: 577211-001

(1) ExpressCard slot bezel

(2) SD Card Reader slot bezel

(3) Hard drive cover

(4) Memory/wireless module compartment cover

(5) Optical drive slot bezel
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Mass storage devices

Item Description Spare part number

(1) Hard drive (includes hard drive connector and hard drive bracket):

■ 500-GB, 7200-rpm 579213-001

■ 500-GB, 5400-rpm 577201-001

■ 320-GB, 7200-rpm 579212-001

■ 320-GB, 5400-rpm 577200-001

■ 250-GB, 7200-rpm 577199-001

■ 160-GB, 7200-rpm 577198-001

(2) Optical drive (includes bezel and bracket):

■ Blu-ray ROM DVD±R/RW SuperMulti Double-Layer Drive with LightScribe 577202-001

■ DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe 577204-001

■ DVD-ROM Drive 577203-001
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Miscellaneous parts

Description Spare part number

AC adapters:

■ 90-W PFC HP Smart Adapter (for use only on computer models equipped with graphics 
subsystems with discrete memory)

463955-001

■ 90-W PFC RC/V HP Smart Adapter (for use only on computer models equipped with 
graphics subsystems with discrete memory)

535593-001

■ 65-W PFC HP Smart Adapter (for use only on computer models equipped with graphics 
subsystems with UMA memory)

463958-001

■ 65-W PFC RC/V HP Smart Adapter (for use only on computer models equipped with 
graphics subsystems with UMA memory)

577170-001

Power cords:

■ For use in Argentina 490371-D01

■ For use in Australia 490371-011

■ For use in Brazil 490371-201

■ For use in Denmark 490371-081

■ For use in Europe, the Middle East, and Africa 490371-021

■ For use in India 490371-D61

■ For use in Israel 490371-BB1

■ For use in Italy 490371-061

■ For use in Japan 490371-291

■ For use in South Africa 490371-AR1

■ For use in South Korea 490371-AD1

■ For use in Switzerland 490371-111

■ For use in Taiwan 490371-AB1

■ For use in the People’s Republic of China 490371-AA1

■ For use in the United Kingdom and Singapore 490371-031

■ For use in the United States 490371-001

Screw Kit:

■ Phillips PM3.0×4.0 screw

■ Phillips PM2.5×11.0 captive screw

■ Phillips PM2.5×8.0 screw

■ Phillips PM2.5×4.0 screw

■ Phillips PM2.0×9.0 captive screw

■ Phillips PM2.0×6.0 captive screw

■ Phillips PM2.0×5.0 screw

■ Phillips PM2.0×4.0 screw

■ Phillips PM2.0×3.0 screw

■ Phillips PM2.0×2.0 broadhead screw

■ Slotted Torx T8M2.5×7.0 screw

■ Torx T8M2.5×6.0 screw

577213-001
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Sequential part number listing

Spare part number Description

463955-001 90-W PFC HP Smart Adapter (for use only on computer models equipped with graphics subsystems 
with discrete memory)

463958-001 65-W PFC HP Smart Adapter (for use only on computer models equipped with graphics subsystems 
with UMA memory)

480985-001 Intel WiFi Link 5100 802.11b/g/n WLAN module for use in all countries and regions except Pakistan, 
Russia, and the Ukraine

482957-001 Intel WiFi Link 5100 802.11b/g WLAN module for use only in Pakistan, Russia, and the Ukraine

483377-002 HSPA EV-DO WWAN module for use in all countries and regions except 
the People’s Republic of China

490371-001 Power cord for use in the United States

490371-011 Power cord for use in Australia

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom and Singapore

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People’s Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

504593-003 Broadcom 4312G 802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

(Continued)
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504593-004 Broadcom 4312G 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, 
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, 
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, 
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, 
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, 
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, 
Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, 
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, 
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, 
the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, 
Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, 
the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, 
St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, 
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, 
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, 
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504664-001 Broadcom 4322AGN 802.11b/g/n WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

504664-002 Broadcom 4322AGN 802.11b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, 
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, 
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, 
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, 
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, 
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, 
Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, 
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, 
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, 
the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, 
Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, 
the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, 
St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Syria, 
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, 
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, 
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

507955-002 Intel Core2 Duo T9600 2.80-GHz processor (6-MB L2 cache, 1066-MHz FSB, includes replacement 
thermal material)

507960-001 Intel Core2 Duo P8700 2.53-GHz processor (3-MB L2 cache, 1066-MHz FSB, includes replacement 
thermal material)

507966-001 Intel Core2 Duo P7370 2.00-GHz processor (3-MB L2 cache, 1066-MHz FSB, includes replacement 
thermal material)

(Continued)
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510100-001 Modem module for use in all countries and regions except Australia and New Zealand

✎ The modem module spare part kit does not include a modem module cable. The modem 
module cable is included in the Cable Kit, spare part number 577214-001.

510100-011 Modem module for use only in Australia and New Zealand

✎ The modem module spare part kit does not include a modem module cable. The modem 
module cable is included in the Cable Kit, spare part number 577214-001.

513598-001 Intel Core Duo T6570 2.10-GHz processor (2-MB L2 cache, 800-MHz FSB, includes replacement 
thermal material, not available in Japan)

513599-001 Intel Core Duo T4200 2.00-GHz processor (1-MB L2 cache, 800-MHz FSB, includes replacement 
thermal material)

535593-001 90-W PFC RC/V HP Smart Adapter (for use only on computer models equipped with graphics 
subsystems with discrete memory)

535835-001 Intel Core Duo T5870 2.00-GHz processor (2-MB L2 cache, 800-MHz FSB, includes replacement 
thermal material, not available in Japan)

537921-001 Bluetooth module

✎ The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth 
module cable is included in the Cable Kit, spare part number 577214-001.

572925-001 Intel Core Duo T3100 1.90-GHz processor (1-MB L2 cache, 800-MHz FSB, includes replacement 
thermal material)

572926-001 Intel Core Duo T3000 1.80-GHz processor (1-MB L2 cache, 800-MHz FSB, includes replacement 
thermal material)

572930-001 Intel Core2 Duo P7570 2.26-GHz processor (3-MB L2 cache, 1066-MHz FSB, includes replacement 
thermal material)

574246-001 Telecom EV-DO CT1 WWAN module for use only in the People’s Republic of China

577170-001 65-W PFC RC/V HP Smart Adapter (for use only on computer models equipped with graphics 
subsystems with UMA memory)

577171-001 Webcam module

577172-001 13.3-in, LED, HD AntiGlare display assembly without webcam in black trim (includes 2 WLAN 
antenna transceivers and cables, nameplate, and logo)

577173-001 13.3-in, LED, HD AntiGlare display assembly with webcam and 2 WWAN antennas in black trim 
(includes 2 WLAN antenna transceivers and cables, 2 WWAN antenna transceivers and cables, 
nameplate, and logo)

577174-001 13.3-in, LED, HD AntiGlare display assembly with webcam in black trim (includes 2 WLAN antenna 
transceivers and cables, nameplate, and logo)

577175-001 13.3-in, LED, HD 1366 × 768 BrightView display assembly with webcam in black trim (includes 
2 WLAN antenna transceivers and cables, nameplate, and logo)

577176-001 13.3-in, LED, HD 1366 × 768 BrightView display assembly with webcam and 2 WWAN antennas in 
black trim (includes 2 WLAN antenna transceivers and cables, 2 WWAN antenna transceivers and 
cables, nameplate, and logo)

577177-001 13.3-in, LED, HD 1366 × 768 BrightView display assembly without webcam in black trim (includes 
2 WLAN antenna transceivers and cables, nameplate, and logo)

577178-001 13.3-in, LED, HD 1280 × 720 BrightView display assembly without webcam in black trim (includes 
2 WLAN antenna transceivers and cables, nameplate, and logo)

577179-001 13.3-in, LED, HD 1280 × 720 BrightView display assembly with webcam in black trim (includes 
2 WLAN antenna transceivers and cables, nameplate, and logo)

(Continued)
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577181-001 13.3-in, LED, HD AntiGlare display assembly without webcam in red trim (includes 2 WLAN antenna 
transceivers and cables, nameplate, and logo)

577182-001 13.3-in, LED, HD AntiGlare display assembly with webcam and 2 WWAN antennas in red trim 
(includes 2 WLAN antenna transceivers and cables, 2 WWAN antenna transceivers and cables, 
nameplate, and logo)

577183-001 13.3-in, LED, HD AntiGlare display assembly with webcam in red trim (includes 2 WLAN antenna 
transceivers and cables, nameplate, and logo)

577184-001 13.3-in, LED, HD 1366 × 768 BrightView display assembly with webcam in red trim (includes 2 WLAN 
antenna transceivers and cables, nameplate, and logo)

577185-001 13.3-in, LED, HD 1366 × 768 BrightView display assembly with webcam and 2 WWAN antennas in 
red trim (includes 2 WLAN antenna transceivers and cables, 2 WWAN antenna transceivers and 
cables, nameplate, and logo)

577186-001 13.3-in, LED, HD 1366 × 768 BrightView display assembly without webcam in red trim (includes 2 
WLAN antenna transceivers and cables, nameplate, and logo)

577187-001 13.3-in, LED, HD 1280 × 720 BrightView display assembly without webcam in red trim (includes 2 
WLAN antenna transceivers and cables, nameplate, and logo)

577188-001 13.3-in, LED, HD 1280 × 720 BrightView display assembly with webcam in red trim (includes 2 WLAN 
antenna transceivers and cables, nameplate, and logo)

577190-001 Display panel cable for use only on computer models not equipped with a webcam

577191-001 Display hinges

577192-001 Display enclosure in black trim

577193-001 Display enclosure in red trim

577194-001 Display bezel for use only on computer models equipped with a webcam

577195-001 Display bezel for use only on computer models not equipped with a webcam

577196-001 1024-MB memory module (1333-MHz, DDR2)

577197-001 2048-MB memory module (1333-MHz, DDR2)

577198-001 160-GB, 7200-rpm hard drive (includes hard drive connector and hard drive bracket)

577199-001 250-GB, 7200-rpm hard drive (includes hard drive connector and hard drive bracket)

577200-001 320-GB, 5400-rpm hard drive (includes hard drive connector and hard drive bracket)

577201-001 500-GB, 5400-rpm hard drive (includes hard drive connector and hard drive bracket)

577202-001 Blu-ray ROM DVD±R/RW SuperMulti Double-Layer Drive with LightScribe (includes bezel 
and bracket)

577203-001 DVD-ROM Drive (includes bezel and bracket)

577204-001 DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe (includes bezel and bracket)

577205-001 Keyboard for use in the United States (includes cable)

577205-031 Keyboard for use in the United Kingdom (includes cable)

577205-041 Keyboard for use in Germany (includes cable)

577205-051 Keyboard for use in France (includes cable)

577205-061 Keyboard for use in Italy (includes cable)

577205-071 Keyboard for use in Spain (includes cable)

577205-081 Keyboard for use in Denmark (includes cable)

577205-091 Keyboard for use in Norway (includes cable)

(Continued)
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577205-121 Keyboard for use in French Canada (includes cable)

577205-131 Keyboard for use in Portugal (includes cable)

577205-141 Keyboard for use in Turkey (includes cable)

577205-161 Keyboard for use in Latin America (includes cable)

577205-171 Keyboard for use in Saudi Arabia (includes cable)

577205-201 Keyboard for use in Brazil (includes cable)

577205-211 Keyboard for use in Hungary (includes cable)

577205-221 Keyboard for use in the Czech Republic (includes cable)

577205-231 Keyboard for use in Slovakia (includes cable)

577205-251 Keyboard for use in Russia (includes cable)

577205-261 Keyboard for use in Bulgaria (includes cable)

577205-281 Keyboard for use in Thailand (includes cable)

577205-291 Keyboard for use in Japan (includes cable)

577205-A41 Keyboard for use in Belgium (includes cable)

577205-AB1 Keyboard for use in Taiwan (includes cable)

577205-AD1 Keyboard for use in South Korea (includes cable)

577205-B31 Keyboard for use in the Netherlands (includes cable)

577205-B71 Keyboard for use in Sweden and Finland (includes cable)

577205-BA1 Keyboard for use in Slovenia (includes cable)

577205-BB1 Keyboard for use in Israel (includes cable)

577205-BG1 Keyboard for use in Switzerland (includes cable)

577205-DD1 Keyboard for use in Iceland (includes cable)

577205-DJ1 Keyboard for use in Greece (includes cable)

577206-001 Fan (includes replacement thermal material)

577207-001 Switch cover in black trim (includes LED board and cable)

577208-001 Switch cover in red trim (includes LED board and cable)

577209-001 Base enclosure (includes 5 rubber feet)

577211-001 Plastics Kit

✎ See “Plastics Kit” on page 3-12 for more Plastics Kit spare part information.

577212-001 Rubber Feet Kit (includes 5 rubber feet and 8 display bezel screw covers)

577213-001 Screw Kit

577214-001 Cable Kit

✎ See “Cable Kit” on page 3-9 for more Cable Kit spare part information.

577215-001 Speakers (include cables)

577216-001 Top cover for use only on computer models equipped with fingerprint reader in black trim 
(includes palm rest, fingerprint reader board and cable, TouchPad and cable, and TouchPad button 
board and cable)

(Continued)
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577217-001 Top cover for use only on computer models not equipped with fingerprint reader in black trim 
(includes palm rest, TouchPad and cable, and TouchPad button board and cable)

577218-001 Top cover for use only on computer models equipped with fingerprint reader in red trim 
(includes palm rest, fingerprint reader board and cable, TouchPad and cable, and TouchPad button 
board and cable)

577219-001 Top cover for use only on computer models not equipped with fingerprint reader in red trim 
(includes palm rest, TouchPad and cable, and TouchPad button board and cable)

577220-001 GL40 system board for use only on computer models equipped with graphics subsystems with UMA 
memory and not equipped with WWAN capability (includes replacement thermal material)

577221-001 GL40 system board for use only on computer models equipped with graphics subsystems with 
UMA memory and equipped with WWAN capability (includes replacement thermal material)

577222-001 PM45 system board for use only on computer models equipped with graphics subsystems with 
discrete memory and not equipped with WWAN capability (includes replacement thermal material)

577223-001 PM45 system board for use only on computer models equipped with graphics subsystems with 
discrete memory and equipped with WWAN capability (includes replacement thermal material)

577224-001 GM45 system board for use only on computer models equipped with graphics subsystems with 
UMA memory and not equipped with WWAN capability (includes replacement thermal material)

577225-001 GM45 system board for use only on computer models equipped with graphics subsystems with 
UMA memory and equipped with WWAN capability (includes replacement thermal material)

577226-001 Heat sink for use only on computer models equipped with a graphics subsystem with UMA memory 
(includes replacement thermal material) 

577227-001 Heat sink for use only on computer models equipped with a graphics subsystem with discrete 
memory (includes replacement thermal material)

577228-001 Display Cable Kit for use only on computer models equipped with WWAN capability (includes WLAN 
and WWAN antenna transceivers and cables and microphones and cables)

577659-001 USB board (includes cable)

577661-001 Power button board for use only on computer models not equipped with WWAN capability (includes 
two cables)

577662-001 Power button board for use only on computer models equipped with WWAN capability (includes 
SIM slot and two cables)

577663-001 Display panel cable for use only on computer models equipped with a webcam

578365-001 Display Cable Kit for use only on computer models not equipped with WWAN capability (includes 
WLAN antenna transceivers and cables and microphones and cables)

579212-001 320-GB, 7200-rpm hard drive (includes hard drive connector and hard drive bracket)

579213-001 500-GB, 7200-rpm hard drive (includes hard drive connector and hard drive bracket)

579319-001 6-cell, 2.20-Ah (37-Wh) Li-ion battery

579320-001 8-cell, 2.55-Ah (73-Wh) Li-ion battery

581926-001 RTC battery

582724-001 Telecom EV-DO CT2 WWAN module for use only in the People’s Republic of China

583090-001 13.3-in, LED, HD 1280 × 720 BrightView display assembly with webcam and 2 WWAN antennas in 
black trim (includes 2 WLAN antenna transceivers and cables, 2 WWAN antenna transceivers and 
cables, nameplate, and logo)

583091-001 13.3-in, LED, HD 1280 × 720 BrightView display assembly with webcam and 2 WWAN antennas in 
red trim (includes 2 WLAN antenna transceivers and cables, 2 WWAN antenna transceivers and 
cables, nameplate, and logo)

Spare part number Description
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Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures: 

■ Flat-bladed screwdriver

■ Phillips P0 screwdriver

■ Phillips P1 screwdriver

■ Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly and 
assembly procedures. 

✎ As you remove each subassembly from the computer, place the subassembly (and all accompanying screws) 
away from the work area to prevent damage. 

Plastic parts

Ä
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care when handling the 
plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and connectors

Ä
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the reassembly 
process. Improper cable placement can damage the computer. 

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat the 
cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid 
bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught or 
snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables tear easily. 
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Drive handling

ÄCAUTION: Drives are fragile components that must be handled with care. To prevent damage to the computer, 
damage to a drive, or loss of information, observe these precautions:
■ Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is off 

or in Hibernation, turn the computer on, and then shut it down through the operating system. 
■ Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid 

touching the connector.
■ Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure 

that the optical drive tray is closed.
■ Handle drives on surfaces covered with at least one inch of shock-proof foam. 
■ Avoid dropping drives from any height onto any surface.
■ After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
■ Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers. 
■ Avoid exposing a drive to temperature extremes or liquids. 
■ If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective packaging 

and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many cases, ESD 
contains enough power to alter device parameters or melt silicon junctions. 

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or 
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred. 

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal cycle. 
Or, the device may function normally for a while, and then degrade in the internal layers, reducing its life 
expectancy. 

ÄCAUTION: To prevent damage to the computer when you are removing or installing internal components, observe 
these precautions:
■ Keep components in their electrostatic-safe containers until you are ready to install them.
■ Use nonmagnetic tools. 
■ Before touching an electronic component, discharge static electricity by using the guidelines described in 

this section.
■ Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
■ If you remove a component, place it in an electrostatic-safe container.
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The following table shows how humidity affects the electrostatic voltage levels generated by different activities.

ÄCAUTION: A product can be degraded by as little as 700 V. 

Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment: 

■ To avoid hand contact, transport products in static-safe tubes, bags, or boxes. 

■ Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging. 

■ Keep ESD-sensitive parts in their containers until they arrive at static-free workstations. 

■ Place items on a grounded surface before them from their containers. 

■ Always be properly grounded when touching a component or assembly. 

■ Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam. 

■ Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized equipment 
used for moving materials is wired to ground, and that proper materials are selected to avoid static charging. 
When grounding is not possible, use an ionizer to dissipate electric charges. 

Typical electrostatic voltage levels 

Relative humidity 

Event 10% 40% 55% 

Walking across carpet 35,000 V 15,000 V 7,500 V 

Walking across vinyl floor 12,000 V 5,000 V 3,000 V 

Motions of bench worker 6,000 V 800 V 400 V 

Removing DIPS from plastic tube 2,000 V 700 V 400 V 

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V 

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V 

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V 

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V 
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Workstation guidelines

Follow these workstation grounding guidelines: 

■ Cover the workstation with approved static-shielding material. 

■ Use a wrist strap connected to a properly grounded work surface, and use properly grounded tools and 
equipment. 

■ Use conductive field service tools, such as cutters, screwdrivers, and vacuums. 

■ When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials. 

■ Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and Styrofoam. 

■ Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these items 
only at static-free workstations. 

■ Avoid contact with pins, leads, or circuitry. 

■ Turn off power and input signals before inserting or removing connectors or test equipment. 

Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation. 

■ When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a 
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap snugly 
against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips to connect a 
wrist strap. 

■ When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be used at 
standing workstations and are compatible with most types of shoes or boots. On conductive floors or 
dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance between the 
operator and ground. To be effective, the conductive strips must be worn in contact with the skin. 

The following grounding equipment is recommended to prevent electrostatic damage: 

■ Antistatic tape 

■ Antistatic smocks, aprons, and sleeve protectors 

■ Conductive bins and other assembly or soldering aids 

■ Nonconductive foam 

■ Conductive tabletop workstations with ground cords of one megohm resistance 

■ Static-dissipative tables or floor mats with hard ties to the ground 

■ Field service kits 

■ Static awareness labels 

■ Material-handling packages 

■ Nonconductive plastic bags, tubes, or boxes 

■ Metal tote boxes 

■ Electrostatic voltage levels and protective materials 

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level 

Antistatic plastic Bags 1,500 V 

Carbon-loaded plastic Floor mats 7,500 V 

Metallized laminate Floor mats 5,000 V 
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Component replacement procedures
This chapter provides removal and replacement procedures. 

There are as many as 76 screws, in 12 different sizes, that must be removed, replaced, or loosened when servicing 
the computer. Make special note of each screw size and location during removal and replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model number provided on 
the service tag.

Item Component Description

(1) Product name This is the product name affixed to the front of the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n) This number provides specific information about the product’s 
hardware components. The part number helps a service 
technician determine what components and parts are needed.

(4) Model description This is the alphanumeric identifier used to locate documents, 
drivers, and support for the computer.

(5) Warranty period This number describes the duration of the warranty period for 
the computer.
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Feet Kit, spare part 
number 577212-001. There are 5 rubber feet that attach to the base enclosure in the locations shown in the 
following illustration.

✎ The three rubber feet 1 on the front edge of the computer are smaller than the 2 rubber feet 2 on the rear edge of 
the computer.
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Battery

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you. 

2. Slide the battery release latch 1 to release the battery. 

3. Remove the battery 2.

Install the battery by inserting it into the battery bay until you hear a click. 

Description Spare part number

8-cell, 2.55-Ah (73-Wh) Li-ion battery 579320-001

6-cell, 2.20-Ah (37-Wh) Li-ion battery 579319-001
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SIM

✎ The SIM is provided by the end user as a security measure for the WWAN module. The SIM should be removed, 
placed into a static-dissipative container, and then replaced when the computer is reassembled.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7). 

Remove the SIM:

1. Press in on the SIM 1 to release it from the SIM slot.

2. Remove the SIM 2 from the computer.

Install the SIM by inserting it into the SIM slot until you hear a click. 
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Hard drive

✎ The hard drive spare part kit includes a hard drive connector and hard drive bracket.

Before removing the hard drive, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

Description Spare part number

500-GB, 7200-rpm hard drive 579213-001

500-GB, 5400-rpm hard drive 577201-001

320-GB, 7200-rpm hard drive 579212-001

320-GB, 5400-rpm hard drive 577200-001

250-GB, 7200-rpm hard drive 577199-001

160-GB, 7200-rpm hard drive 577198-001
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Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×6.0 captive screws 1 that secure the hard drive cover to the computer. 

3. Lift the left side 2 of the hard drive cover to detach it from the computer.

4. Remove the hard drive cover 3. The hard drive cover is included in the Plastics Kit, spare part number 
577211-001.

5. Loosen the Phillips PM2.5×11.0 captive screw 1 that secures the hard drive to the computer.

6. Grasp the Mylar tab 2 in the hard drive bay, and then lift it up to disconnect the hard drive from the 
system board.

7. Grasp the Mylar tab 3 on the hard drive, and then remove the hard drive 4 from the hard drive bay. 
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8. If it is necessary to replace the hard drive bracket or connector, follow these steps:

a. Disconnect the hard drive connector 1 from the hard drive.

b. Remove the four Phillips PM3.0×4.0 screws 2 that secure the hard drive bracket to the hard drive.

c. Lift the bracket 3 straight up to remove it from the hard drive. 

Reverse this procedure to reassemble and install the hard drive. 
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WLAN module

Description Spare part number

802.11b/g/n WLAN module:

■ Intel Wi-Fi Link 5100 802.11b/g/n WLAN module for use in all countries and regions except 
Pakistan, Russia, and the Ukraine

480985-001

■ Broadcom 4322AGN 802.11b/g/n WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

504664-001

■ Broadcom 4322AGN 802.11b/g/n WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, 
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, 
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, 
Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African 
Republic, Chad, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, 
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, 
Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, 
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, 
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, 
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, 
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, 
Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, 
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, 
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, 
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, 
Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, 
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, 
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, 
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, 
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, 
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, 
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504664-002

Intel Wi-Fi Link 5100 802.11b/g WLAN module for use only in Pakistan, Russia, and the Ukraine 482957-001

(Continued)
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Before removing the WLAN module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

802.11b/g WLAN module:

■ Broadcom 4312G 802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

504593-003

■ Broadcom 4312G 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, 
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, 
Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, 
Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, 
the Central African Republic, Chad, Colombia, Comoros, the Congo, Costa Rica, Croatia, 
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, 
Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, 
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, 
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, 
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, 
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, 
Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, 
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, 
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, 
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, 
Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, 
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, 
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, 
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, 
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, 
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, 
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

Description Spare part number
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Remove the WLAN module:

Ä
CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in 
the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module 
and then receive a warning message, remove the module to restore computer functionality, and then contact technical support 
through Help and Support.

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×6.0 captive screws 1 that secure the memory/wireless module compartment 
cover to the computer.

3. Lift the left side of the cover 2 to detach it from the computer.

4. Remove the memory/wireless module compartment cover 3. The memory/wireless module compartment 
cover is included in the Plastics Kit, spare part number 577211-001.
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5. Disconnect the WLAN antenna cables 1 from the terminals on the WLAN module.

✎The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The white 
WLAN antenna cable is connected to the WLAN module “Aux” terminal. 

6. Remove the two Phillips PM2.5×4.0 screws 2 that secure the WLAN module to the computer. (The WLAN 
module tilts up.)

7. Remove the WLAN module 3 by pulling it away from the slot at an angle. 

✎WLAN modules are designed with a notch 4 to prevent incorrect insertion of the WLAN module into 
the WLAN module slot.

Reverse this procedure to install the WLAN module. 
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Memory module

Before removing the memory module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the memory/wireless module compartment cover (see “WLAN module” on page 4-12).

Remove the memory module:

✎ The top memory module slot is for expansion memory, and the bottom slot is for primary memory.

1. Pull away the retention clips 1 on each side of the memory module to release the memory module. (The 
memory module tilts up.)

Ä
CAUTION: To prevent damage to the memory module, hold it by the edges only. Do not touch the components on the memory 
module.

2. Grasp the edge of the memory module 2, and then pull it out of the memory module slot.

✎Memory modules are designed with a notch 3 to prevent incorrect insertion into the memory 
module slot.

Reverse this procedure to install a memory module.

Description Spare part number

2048-MB memory module (1333-MHz, DDR2) 577197-001

1024-MB memory module (1333-MHz, DDR2) 577196-001
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WWAN module

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the memory/wireless module compartment cover (see “WLAN module” on page 4-12).

Remove the WWAN module:

Ä
CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in the 
computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module and 
then receive a warning message, remove the module to restore computer functionality, and then contact technical support through 
Help and Support.

1. Position the computer with the front toward you.

2. Disconnect the WWAN antenna cables 1 from the terminals on the WWAN module.

✎The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The blue 
WWAN antenna cable is connected to the WWAN module “Aux” terminal. 

3. Remove the two Phillips PM2.5×4.0 screws 2 that secure the WWAN module to the computer. (The WWAN 
module tilts up.)

4. Remove the WWAN module 3 by pulling it away from the slot at an angle. 

✎WWAN modules are designed with a notch 4 to prevent incorrect insertion of the WWAN module into 
the WWAN module slot.

Reverse this procedure to install the WWAN module. 

Description Spare part number

HSPA EV-DO WWAN module for use in all countries and regions except 
the People’s Republic of China

483377-002

Telecom EV-DO CT1 WWAN module for use only in the People’s Republic of China 574246-001

Telecom EV-DO CT2 WWAN module for use only in the People’s Republic of China 582724-001
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Optical drive

✎ The optical drive spare part kit includes an optical drive bezel and bracket.

Before removing the optical drive, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

Remove the optical drive:

1. Remove the slotted Phillips PM2.5×8.0 screw 1 that secures the optical drive to the computer.

2. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access 2, and then press the tab to the 
left to release the optical drive from the computer.

3. Remove the optical drive 3 from the optical drive bay.

Description Spare part number

Blu-ray ROM DVD±R/RW SuperMulti Double-Layer Drive with LightScribe 577202-001

DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe 577204-001

DVD-ROM Drive 577203-001
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4. If it is necessary to replace the optical drive bracket, follow these steps:

a. Position the optical drive with the rear toward you. 

b. Remove the three Phillips PM2.0×4.0 screws 1 that secure the optical drive bracket to the optical drive. 

c. Remove the optical drive bracket 2. 

Reverse this procedure to reassemble and install the optical drive. 
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Keyboard and switch cover

✎ The switch cover spare part kit includes an LED board and cable.

✎ The keyboard spare part kit includes a keyboard cable.

Before removing the keyboard and switch cover, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

Description Spare part number

Switch cover in black trim 577207-001

Switch cover in red trim 577208-001

Keyboard for use in country 
or region: Spare part number

Keyboard for use in country 
or region: Spare part number

■ Belgium 577205-A41 ■ Norway 577205-091

■ Brazil 577205-201 ■ Portugal 577205-131

■ Bulgaria 577205-261 ■ Russia 577205-251

■ The Czech Republic 577205-221 ■ Saudi Arabia 577205-171

■ Denmark 577205-081 ■ Slovakia 577205-231

■ France 577205-051 ■ Slovenia 577205-BA1

■ French Canada 577205-121 ■ South Korea 577205-AD1

■ Germany 577205-041 ■ Spain 577205-071

■ Greece 577205-DJ1 ■ Sweden and Finland 577205-B71

■ Hungary 577205-211 ■ Switzerland 577205-BG1

■ Iceland 577205-DD1 ■ Taiwan 577205-AB1

■ Israel 577205-BB1 ■ Thailand 577205-281

■ Italy 577205-061 ■ Turkey 577205-141

■ Japan 577205-291 ■ The United Kingdom 577205-031

■ Latin America 577205-161 ■ The United States 577205-001

■ The Netherlands 577205-B31
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Remove the keyboard and switch cover:

1. Position the computer with the front toward you.

2. Remove the following screws:

❏ Two slotted Torx T8M2.5×7.0 screws 1 that secure the switch cover to the computer

❏ Two Phillips PM2.0×5.0 screws 2 that secure the switch cover to the computer in the battery bay

❏ One Phillips PM2.0×2.0 broadhead screw 3 that secures the switch cover to the computer in the battery bay

❏ Two slotted Torx T8M2.5×7.0 screws 4 that secure the keyboard to the computer

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Lift the switch cover until it releases from the computer.
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6. Lift the rear edge 1 of the keyboard until it rests at an angle.

7. Slide the keyboard 2 back until it rests on the switch cover and display.

8. Release the zero insertion force (ZIF) connector 1 to which the keyboard cable is attached, and then 
disconnect the keyboard cable 2 from the system board.
4–22 Maintenance and Service Guide



Removal and replacement procedures
9. Remove the keyboard.

10. Release the ZIF connector 1 to which the LED board cable is attached, and then disconnect the LED board 
cable 2 from the system board.

11. Detach the LED board cable 3 from the top cover. (The LED board cable is attached to the top cover with 
double-sided tape.)

12. Disconnect the speaker cable 4 from the system board.

13. Remove the switch cover 5.

Reverse this procedure to install the keyboard and switch cover.
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Speakers

Before removing the speakers, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the keyboard and switch cover (see “Keyboard and switch cover” on page 4-20).

Remove the speakers:

1. Turn the switch cover upside down, with the front edge toward you.

2. Remove the speaker cable 1 from the clips built into the switch cover.

3. Remove the four Phillips PM2.0×4.0 screws 2 that secure the speakers to the switch cover.

4. Remove the speakers 3.

Reverse this procedure to install the speakers.

Description Spare part number

Speakers (include cables) 577215-001
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Palm rest

✎ The palm rest is included with the top cover. See “Top cover” on page 4-36 for top cover spare part and removal 
information.

Before removing the palm rest, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the keyboard and switch cover (see “Keyboard and switch cover” on page 4-20).

Remove the palm rest:

1. Close the computer.

2. Turn the computer upside down, with the front toward you.

3. Remove the slotted Torx T8M2.5×7.0 screw that secures the palm rest to the computer.
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4. Release the ZIF connector 1 to which the TouchPad cable is attached, and then disconnect the TouchPad 
cable 2 from the system board.

5. Lift the rear edge of the palm rest 3 until it detaches from the computer, and then swing the palm rest up and 
forward until it rests upside down in front of the computer.

6. Disconnect the fingerprint reader board cable 1 from the system board.

7. Remove the palm rest 2.

Reverse this procedure to install the palm rest.
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Display assembly

✎ The display assembly spare part kit includes two WLAN antenna transceivers and cables, nameplate, and logo.

Before removing the display assembly, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Disconnect the wireless antenna cables from the WLAN module (see “WLAN module” on page 4-12) and 
WWAN module (see “WWAN module” on page 4-17).

6. Remove the keyboard and switch cover (see “Keyboard and switch cover” on page 4-20).

Description Spare part number

13.3-in, LED, HD display assembly:

■ AntiGlare display assembly with webcam and 2 WWAN antennas in black trim 577173-001

■ AntiGlare display assembly with webcam and 2 WWAN antennas in red trim 577182-001

■ AntiGlare display assembly with webcam in black trim 577174-001

■ AntiGlare display assembly with webcam in red trim 577183-001

■ AntiGlare display assembly without webcam in black trim 577172-001

■ AntiGlare display assembly without webcam in red trim 577181-001

■ 1366 × 768 BrightView display assembly with webcam and 2 WWAN antennas in black trim 577176-001

■ 1366 × 768 BrightView display assembly with webcam and 2 WWAN antennas in red trim 577185-001

■ 1366 × 768 BrightView display assembly with webcam in black trim 577175-001

■ 1366 × 768 BrightView display assembly with webcam in red trim 577184-001

■ 1366 × 768 BrightView display assembly without webcam in black trim 577177-001

■ 1366 × 768 BrightView display assembly without webcam in red trim 577186-001

■ 1280 × 720 BrightView display assembly with webcam and 2 WWAN antennas in black trim 583090-001

■ 1280 × 720 BrightView display assembly with webcam and 2 WWAN antennas in red trim 583091-001

■ 1280 × 720 BrightView display assembly with webcam in black trim 577179-001

■ 1280 × 720 BrightView display assembly with webcam in red trim 577188-001

■ 1280 × 720 BrightView display assembly without webcam in black trim 577178-001

■ 1280 × 720 BrightView display assembly without webcam in red trim 577187-001
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Remove the display assembly:

1. Close the computer.

2. Turn the computer upside down, with the front toward you.

3. Remove the WLAN and WWAN antenna cables 1 from the clips 2 built into the base enclosure.

4. Turn the computer display-side up, with the front toward you.

5. Open the computer as far as possible.

6. Disconnect the microphone cable 1 from the system board.

7. Remove the wireless antenna cables 2 from the opening in the top cover.

8. Remove the wireless antenna cables and the microphone cable from the clips 3 and routing channel built into 
the top cover.

9. Release the grounding tape 4 that covers the wireless antenna cables and microphone cable.
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✎When installing the display assembly, be sure to complete the following steps to properly route the 
wireless antenna cables. Failure to follow these guidelines can result in degraded wireless reception.

a. Route the wireless antenna cables and microphone cable inside the clips 1 built into the top cover.

b. Align the exposed sections of the wireless antenna cables 2 with the grounding pad 3 attached to the 
top cover.

c. Secure the wireless antenna cables to the grounding pad with the grounding tape 4 attached to the 
top cover.

10. Disconnect the display panel cable 1 from the system board.

11. Release the display panel cable from the clip 2 that secures it.
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ÄCAUTION: Support the display assembly when removing the following screws. Failure to support the display 
assembly can result in damage to the display assembly and other computer components.

12. Remove the five Torx T8M2.5×6.0 screws 1 that secure the display assembly to the computer.

✎The front-right screw on the right hinge secures a ground loop 2 that branches off of the display 
panel cable.

13. Lift the display assembly 3 straight up and remove it.

14. If it is necessary to replace the display bezel or any of the display assembly internal components:

a. Remove the four rubber screw covers 1 and the four Torx T8M2.5×6.0 screws 2 that secure the display 
bezel to the display assembly.
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b. Flex the inside edges of the top edge 1, the left and right sides 2, and the bottom edge 3 of the display 
bezel until the bezel disengages from the display enclosure.

c. Remove the display bezel 4. The display bezel is available using the following spare part numbers:

◆ 577194-001—for use only on computer models equipped with a webcam

◆ 577195-001—for use only on computer models not equipped with a webcam

15. If it is necessary to replace the webcam module:

a. Remove the four Phillips PM2.5×4.0 screws 1 that secure the display panel to the display enclosure.

b. Remove the display panel cable from the clips 2 built into the display enclosure.

c. Remove the display panel 3.
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d. Release the webcam module 1 as far from the display enclosure as the webcam module cable allows.

e. Disconnect the webcam module cable 2 from the webcam module.

f. Remove the webcam module 3. The webcam module is available using spare part number 577171-001.

16. If it is necessary to replace the display hinges:

a. Remove six Phillips PM2.5×3.0 screws 1 that secure the display hinges to the display panel.

b. Remove the display hinges 2.
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17. If it is necessary to replace the display panel cable:

a. Turn the display panel upside down, with the bottom edge toward you.

b. Fold back the flap 1 in the display shielding that covers the display panel cable connector.

c. Release the adhesive support strip 2 that secures the display panel cable to the display panel.

d. Release the support bar 3 that secures the display panel cable to the display panel.

e. Disconnect the display panel cable 4 from the connector on the back of the display panel.

f. Remove the display panel cable 5. The display panel cable is available using the following spare part 
numbers:

◆ 577663-001—for use only on computer models equipped with a webcam

◆ 577190-001—for use only on computer models not equipped with a webcam

18. If it is necessary to replace the microphones and cables:

a. Release the microphone receivers 1 from the clips built into the display enclosure.

b. Release the microphone cables 2 from the clips and routing channel built into the left side of the 
display enclosure.

c. Remove the microphones and cables 3. The microphones and cables are included in the Display Cable Kits, 
using the following spare part numbers:

◆ 577228-001—for use only on computer models equipped with WWAN capability

◆ 578365-001—for use only on computer models not equipped with WWAN capability
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19. If it is necessary to replace the WLAN wireless antenna transceivers and cables:

a. Detach the transceivers 1 from the display enclosure. (The transceivers are attached to the enclosure with 
double-sided tape.)

b. Release the WLAN wireless antenna cables 2 from the clips and routing channel built into the left side of 
the display enclosure.

c. Remove the WLAN wireless antenna transceivers and cables. The wireless antenna transceivers and cables 
are included in the Display Cable Kits, using the following spare part numbers:

◆ 577228-001—for use only on computer models equipped with WWAN capability

◆ 578365-001—for use only on computer models not equipped with WWAN capability
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20. If it is necessary to replace the WWAN wireless antenna transceivers and cables:

a. Detach the transceivers 1 from the display enclosure. (The transceivers are attached to the enclosure with 
double-sided tape.)

b. Release the WWAN wireless antenna cables 2 from the clips and routing channels built into the left and 
right sides of the display enclosure.

c. Remove the WWAN wireless antenna transceivers and cables. The wireless antenna transceivers and cables 
are included in the Display Cable Kits, using the following spare part numbers:

◆ 577228-001—for use only on computer models equipped with WWAN capability

◆ 578365-001—for use only on computer models not equipped with WWAN capability

Reverse this procedure to reassemble and install the display assembly.
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Top cover

✎ The top cover spare part kit includes a palm rest, TouchPad and cable, and TouchPad button board and cable.

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-7).

5. Remove the following components:

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the four slotted Torx T8M2.5×7.0 screws 1 and the three Phillips PM2.0×3.0 screws 2 that secure the 
top cover to the base enclosure.

Description Spare part number

For use only on computer models equipped with fingerprint reader in black trim (includes fingerprint 
reader board and cable)

577216-001

For use only on computer models equipped with fingerprint reader in red trim (includes fingerprint 
reader board and cable)

577218-001

For use only on computer models not equipped with fingerprint reader in black trim 577217-001

For use only on computer models not equipped with fingerprint reader in red trim 577219-001
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3. Turn the computer right-side up, with the front toward you.

4. Disconnect the power connector cables 1 from the system board.

5. Release the power connector cables from the clips 2 and routing channel built into the top cover.

6. Disconnect the network cable 3 from the system board.

7. Release the network cable from the clips 4 and routing channel built into the top cover.

8. Remove the five slotted Torx T8M2.5×7.0 screws 1 and the Torx T8M2.5×6.0 screw 2 that secure the top 
cover to the base enclosure.
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9. Release the ExpressCard slot bezel 1 by pressing in on it, and then remove the bezel 2.

10. Lift the rear edge 3 of the top cover until it detaches from the base enclosure.

11. Remove the top cover 4 by lifting it straight up.

Reverse this procedure to install the top cover. 
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USB board

Before removing the USB board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

g. Top cover (see “Top cover” on page 4-36)

Remove the USB board:

1. Disconnect the USB board cable 1 from the system board.

2. Detach the USB board cable 2 from the base enclosure. (The USB board cable is attached to the base 
enclosure with double-sided tape.)

3. Remove the USB board 3 and cable.

Reverse this procedure to install the USB board.

Description Spare part number

USB board (includes cable) 577659-001
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Bluetooth module

✎ The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth module cable is 
included in the Cable Kit, spare part number 577214-001.

Before removing the Bluetooth module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

g. Top cover (see “Top cover” on page 4-36)

Remove the Bluetooth module and cable: 

1. Release the Bluetooth module 1 by sliding it forward until the rear edge of the module is clear of the opening 
in the base enclosure, and then sliding it 2 to the right until it is clear of the clips built into the top cover.

2. Remove the Bluetooth module 3.

3. Disconnect the Bluetooth module cable 4 from the Bluetooth module.

Description Spare part number

Bluetooth module 537921-001
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4. If it is necessary to replace the Bluetooth module cable:

a. Disconnect the Bluetooth module cable 1 from the system board.

b. Release the Bluetooth module cable from the clips 2 built into the base enclosure.

c. Remove the Bluetooth module cable 3.

Reverse this procedure to install the Bluetooth module and cable.
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Modem module

✎ The modem module spare part kit does not include a modem module cable. The modem module cable is 
included in the Cable Kit, spare part number 577214-001.

Before removing the modem module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

g. Top cover (see “Top cover” on page 4-36)

Description Spare part number

Modem module for use in all countries and regions except Australia and New Zealand 510100-001

Modem module for use only in Australia and New Zealand 510100-011
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Remove the modem module:

1. Remove the two Phillips PM2.0×4.0 screws 1 that secure the modem module to the system board.

2. Lift the modem module 2 away from the system board to disconnect it.

3. Disconnect the modem module cable 3 from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.
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Modem module cable

✎ The modem module cable is included in the Cable Kit, spare part number 577214-001.

Before removing the modem module cable, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

g. Top cover (see “Top cover” on page 4-36)

h. USB board (see “USB board” on page 4-39)

Remove the modem module cable:

1. Disconnect the modem module cable 1 from the modem module.

2. Release the modem module cable 2 from the clips built into the base enclosure.

3. Release the RJ-11 connector 3 from the clip built into the base enclosure.

4. Remove the modem module cable.

Reverse this procedure to install the modem module cable.
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Power connector cable

✎ The power connector cable is included in the Cable Kit, spare part number 577214-001.

Before removing the power connector cable, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

g. Top cover (see “Top cover” on page 4-36)

Remove the power connector cable:

1. Release the power connector 1 from the clip built into the base enclosure.

2. Remove the power connector cable 2.

Reverse this procedure to install the power connector cable.
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Power button board

✎ The power button board spare part kit includes two cables.

Before removing the power button board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

g. Top cover (see “Top cover” on page 4-36)

Remove the power button board:

1. Release the two ZIF connectors 1 to which the two power button board cables are attached, and then 
disconnect the cables 2 from the system board.

2. Detach the power button board 3 from the base enclosure. (The power button board is attached to the base 
enclosure with double-sided tape.)

3. Remove the power button board and cables.

Reverse this procedure to install the power button board.

Description Spare part number

Power button board for use only on computer models equipped with WWAN capability (includes 
SIM slot)

577662-001

Power button board for use only on computer models not equipped with WWAN capability 577661-001
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System board

✎ The system board spare part kit includes replacement thermal material.

Before removing the system board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components:

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

g. Top cover (see “Top cover” on page 4-36)

When replacing the system board, be sure that the following additional components are removed from the defective 
system board and installed on the replacement system board: 

■ SIM (see “SIM” on page 4-8)

■ WLAN module (see “WLAN module” on page 4-12)

■ Memory modules (see “Memory module” on page 4-16)

■ WWAN module (see “WWAN module” on page 4-17)

■ Modem module (see “Modem module” on page 4-42)

■ Fan and heat sink (see “Fan and heat sink” on page 4-51)

■ RTC battery (see “RTC battery” on page 4-54)

■ Processor (see “Processor” on page 4-55)

Description Spare part number

PM45 system board for use only on computer models equipped with graphics subsystems with discrete memory:

■ For use only on computer models equipped with WWAN capability 577223-001

■ For use only on computer models not equipped with WWAN capability 577222-001

GM45 system board for use only on computer models equipped with graphics subsystems with UMA memory:

■ For use only on computer models equipped with WWAN capability 577225-001

■ For use only on computer models not equipped with WWAN capability 577224-001

GL40 system board for use only on computer models equipped with graphics subsystems with UMA memory:

■ For use only on computer models equipped with WWAN capability 577221-001

■ For use only on computer models not equipped with WWAN capability 577220-001
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Remove the system board:

1. Release the ZIF connector 1 to which the USB board cable is attached, and then disconnect the USB board 
cable from the system board.

2. Disconnect the Bluetooth module cable 2 from the system board.

3. Disconnect the modem module cable 3 from the modem module.

4. Release the SD Card Reader slot bezel 1 by pressing in on it, and then remove the bezel 2.

5. Release the two ZIF connectors 3 to which the two power button board cables are attached, and then 
disconnect the cables from the system board.
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6. Remove the two Torx T8M2.5×6.0 screws 1 that secure the system board to the base enclosure.

7. Loosen the Phillips PM2.0×9.0 captive screw 2 that secures the fan and system board to the base enclosure.

8. Use the optical drive connector 1 to lift the left side of the system board 2 until it rests at an angle.

9. Remove the system board 3 by sliding it away from the base enclosure at an angle.

Reverse this procedure to install the system board.
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Network cable

✎ The network cable is included in the Cable Kit, spare part number 577214-001.

Before removing the network cable, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

g. Top cover (see “Top cover” on page 4-36)

h. System board (see “System board” on page 4-47)

Remove the network cable:

1. Release the RJ-45 connector 1 from the clip built into the base enclosure.

2. Remove the network cable 2.

Reverse this procedure to install the network cable.
4–50 Maintenance and Service Guide



Removal and replacement procedures
Fan and heat sink

✎ The fan and heat sink spare part kits include replacement thermal material.

✎ To properly ventilate the computer, allow at least 7.6 cm (3 in) of clearance on the left side of the computer. The 
computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is designed to 
turn on automatically when high temperature conditions exist. These conditions are affected by high external 
temperatures, system power consumption, power management/battery conservation configurations, battery fast 
charging, and software requirements. Exhaust air is displaced through the ventilation grill located on the left side 
of the computer. 

Before removing the fan and heat sink, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

g. Top cover (see “Top cover” on page 4-36)

h. System board (see “System board” on page 4-47)

Description Spare part number

Fan 577206-001

Description Spare part number

Heat sink for use only on computer models equipped with a graphics subsystem with discrete 
memory

577227-001

Heat sink for use only on computer models equipped with a graphics subsystem with UMA memory 577226-001
Maintenance and Service Guide 4–51



Removal and replacement procedures
Remove the fan and heat sink:

1. Disconnect the fan cable from the system board.

2. Turn the system board upside down, with the audio connectors toward you.

3. Following the 1, 2, 3, 4, 5, 6 sequence stamped into the heat sink, loosen the six Phillips PM2.0×9.0 captive 
screws 1 that secure the fan and heat sink to the system board.

✎Due to the adhesive quality of the thermal material located between the heat sink and system board 
components, it may be necessary to move the heat sink from side to side to detach it.

4. Remove the fan and heat sink 2.
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Removal and replacement procedures
✎The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system board 
each time the fan and heat sink are removed:

■ Thermal paste is used on the processor 1 and the heat sink section 2 that services it.

■ Thermal pads are used on the Northbridge chip 3 and the heat sink section 4 that services it.

■ Thermal pads are used on the graphics subsystem memory module 5 and the heat sink section 6 that 
services it.

Replacement thermal material is included with all system board, heat sink, and processor spare part kits.

5. If it is necessary to replace the fan:

a. Remove the four Phillips PM2.0×4.0 screws 1 that secure the fan to the heat sink.

b. Remove the heat sink 2 by lifting it straight up.

Reverse this procedure to install the fan and heat sink.
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Removal and replacement procedures
RTC battery

Before removing the RTC battery, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

g. Top cover (see “Top cover” on page 4-36)

h. System board (see “System board” on page 4-47)

Remove the RTC battery:

1. Turn the system board upside down, with the audio connectors toward you.

2. Disconnect the RTC battery cable 1 from the system board.

3. Detach the RTC battery 2 from the SD Card Reader. (The RTC battery is attached to the SD Card Reader with 
double-sided tape.)

Reverse this procedure to install the RTC battery.

Description Spare part number

RTC battery 581926-001
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Removal and replacement procedures
Processor

✎ The processor spare part kit includes replacement thermal material.

Before removing the processor, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet, and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-7). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-9)

b. Memory/wireless module compartment cover (see “WLAN module” on page 4-12)

c. Optical drive (see “Optical drive” on page 4-18)

d. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

e. Palm rest (see “Palm rest” on page 4-25)

f. Display assembly (see “Display assembly” on page 4-27)

g. Top cover (see “Top cover” on page 4-36)

h. System board (see “System board” on page 4-47)

i. Fan and heat sink (see “Fan and heat sink” on page 4-51)

Description Spare part number

Intel Core2 Duo processors:

■ T9600 2.80-GHz processor, 6-MB L2 cache, 1066-MHz FSB 507955-002

■ P8700 2.53-GHz processor, 3-MB L2 cache, 1066-MHz FSB 507960-001

■ P7570 2.26-GHz processor, 3-MB L2 cache, 1066-MHz FSB 572930-001

■ P7370 2.00-GHz processor, 3-MB L2 cache, 1066-MHz FSB 507966-001

Intel Core Duo processors:

■ T6570 2.10-GHz processor, 2-MB L2 cache, 800-MHz FSB (not available in Japan) 513598-001

■ T5870 2.00-GHz processor, 2-MB L2 cache, 800-MHz FSB (not available in Japan) 535835-001

■ T4200 2.00-GHz processor, 1-MB L2 cache, 800-MHz FSB 513599-001

■ T3100 1.90-GHz processor, 1-MB L2 cache, 800-MHz FSB 572925-001

■ T3000 1.80-GHz processor, 1-MB L2 cache, 800-MHz FSB 572926-001
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Removal and replacement procedures
Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw 1 one-half turn counterclockwise, until you 
hear a click. 

2. Lift the processor 2 straight up and remove it. 

✎When you install the processor, the gold triangle 3 on the processor must be aligned with the triangle 4 
embossed on the processor socket. 

Reverse this procedure to install the processor.
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5
Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not 
working or will not load.

✎ Some of the Computer Setup menu items listed in this chapter may not be supported by your computer.

An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy 
support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and System 
Configuration menus.

To navigate and select in Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

❏ To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a 
pointing device to click the item.

❏ To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use 
the up arrow key or the down arrow key.

❏ To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the 
on-screen instructions.

✎You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to 
navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.
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Computer Setup
To exit Computer Setup, use one of the following methods:
■ To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of the screen, 

and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press enter.

– or –

■ To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen, and 
then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit Computer Setup, click the Save icon in the lower-left corner of the screen, and 
then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

✎ Your password settings, language settings, security settings, and hard drive mode are not changed when you 
restore the factory settings.
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Computer Setup
Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

✎ Some of the Computer Setup menu items listed in this chapter may not be supported by your computer.

File menu

Select To do this

System Information ■ View identification information for the computer and 
the batteries in the system.

■ View specification information for the processor, cache and 
memory size, system ROM, video revision, and keyboard 
controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with 
the original factory settings. (Hard drive mode, password 
settings, and security settings are not changed when you 
restore the factory settings.)

BIOS security to factory default Reset the BIOS security policies and clear the ProtectTools 
user information.

Ignore changes and exit Cancel any changes entered during the current session. 
Then exit and restart the computer.

Save changes and exit Save any changes entered during the current session. 
Then exit and restart the computer. Your changes go into 
effect when the computer restarts.
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Computer Setup
Security menu

✎ Some of the menu items listed in this section may not be supported by your computer.

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator password) ■ Create a new BIOS user account.

■ View a list of ProtectTools users.

Password Policy (requires a BIOS administrator password) Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (enabled by default).

Fingerprint Reset on Reboot (If Present) Reset/clear the fingerprint reader ownership (select models 
only; disabled by default).

Allow Reset of HP ProtectTools security keys Enable/disable reset of HP ProtectTools security keys 
(disabled by default).

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security 
questions and answers used if you forget your password.

DriveLock Passwords ■ Enable/disable DriveLock on any computer hard drive 
(enabled by default).

■ Change a DriveLock user password or master password.

✎ DriveLock settings are accessible only when you enter 
Computer Setup by turning on (not restarting) 
the computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary 
hard drive or the drive in the upgrade bay.

Ä If you run Disk Sanitizer, the data on the selected drive 
is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and 
ownership tag.
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Computer Setup
Diagnostics menu

System Configuration menu

✎ Some of the listed System Configuration options may not be supported by your computer.

Select To do this

System Diagnostics Menu ■ System Information—Displays the following information:

❐ Identification information for the computer and 
the batteries in the system.

❐ Specification information for the processor, cache and 
memory size, system ROM, video revision, and 
keyboard controller version.

■ Start-up Test—Verifies the system components needed for 
starting the computer.

■ Run-In Test—Runs a comprehensive check on 
system memory.

■ Hard Disk Test—Runs a comprehensive self-test on any 
hard drive in the system.

Select To do this

Language  Change the Computer Setup language.

Boot Options ■ Set a Startup Menu delay (in seconds).

■ Enable/disable Custom Logo (disabled by default).

■ Enable/disable CD-ROM boot (enabled by default).

■ Enable/disable SD Card boot (enabled by default).

■ Enable/disable floppy boot (enabled by default).

■ Enable/disable PXE Internal NIC boot (enabled by default).

■ Set the Express Boot Popup delay in seconds.

■ Set the boot order.

Device Configurations ■ Enable/disable USB legacy support (enabled by default). 
When enabled, USB legacy support allows the following:

❐ Use of a USB keyboard in Computer Setup even when 
a Windows operating system is not running.

❐ Startup from bootable USB devices, including 
a hard drive, diskette drive, or optical drive connected by 
a USB port to the computer.

■ Enable/disable fan always on while connected to an 
AC outlet (enabled by default).

■ Enable/disable Data Execution Prevention. When enabled, 
the processor can disable some virus code execution, 
which helps to improve computer security (enabled 
by default).

(Continued)
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Computer Setup
Select To do this

System Configuration menu (continued)

Device Configurations (continued) ■ SATA (Serial Advanced Technology Attachment) 
device mode. The following options are available:

❐ AHCI (Advanced Host Controller Interface)

❐ IDE (Integrated Drive Electronics)
❐ RAID (select models only)

✎ Availability of the preceding options varies by 
computer model.

■ Enable/disable HP QuickLock 2 (enabled by default).

■ Enable/disable Virtualization Technology (disabled 
by default).

■ Enable/disable Dual Core CPU (select models only; 
enabled by default).

■ Enable/disable Unified Extensible Firmware Interface 
(UEFI) boot mode (disabled by default).

Built-In Device Options ■ Enable/disable the wireless button state 
(enabled by default).

■ Enable/disable the embedded WLAN device (enabled 
by default).

■ Enable/disable embedded Bluetooth device radio 
(enabled by default).

■ Enable/disable the Network Interface Controller (LAN) 
(enabled by default).

■ Enable/disable LAN/WLAN switching (disabled by default).

■ Set the wake on LAN state. Options include the following:

❐ Disabled
❐ Boot to Network (set by default)

❐ Follow Boot Order
■ Enable/disable the optical disc drive (select models only; 

enabled by default).

■ Enable/disable the fingerprint device (select models only; 
enabled by default).

■ Enable/disable the integrated camera (enabled by default).

■ Enable/disable a modem device (enabled by default).

■ Enable/disable the microphone (enabled by default).

Port Options (all are enabled by default) ✎ All port options are enabled by default.

■ Enable/disable the flash media reader.

■ Enable/disable the USB port.

Ä Disabling the USB port also disables MultiBay 
devices and ExpressCard devices on the 
advanced port replicator.

■ Enable/disable the ExpressCard slot.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.
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6
Specifications

Computer specifications

Metric U.S.

Dimensions

Length 22.78 cm 8.97 in

Width 32.49 cm 12.79 in

Height (front to back) 2.73 to 3.68 cm 1.07 to 1.45 in

Weight 1.9 kg 4.19 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A - 65 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

✎ Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this 
range of temperatures.
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Specifications
13.3-in display specifications

Metric U.S. 

Dimensions

Height 17.8 cm 7.0 in

Width 28.4 cm 11.2 in

Diagonal 33.6 cm 13.3 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1366 × 768 or 1280 × 720

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle ±40° horizontal, +120°/-40° vertical (typical)
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Specifications
Hard drive specifications

500-GB* 320-GB* 250-GB* 160-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.0 ms 1.5 ms 2.0 ms 2.0 ms

Average 14.0 ms 12.0 ms 12.0 ms 12.0 ms

Maximum 22.0 ms 22.0 ms 22.0 ms 22.0 ms

Logical blocks 976,773,168 625,142,448 488,397,168 312,581,808

Disc rotational speed 7200 and 
5400 rpm

7200 and 
5400 rpm

7200 rpm 7200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive 
specifications may differ slightly.

✎ Certain restrictions and exclusions apply. Contact technical support for details.
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Specifications
Blu-ray ROM DVD±R/RW SuperMulti Double-Layer Drive specifications

Applicable disc Read: Write: 

BD-ROM, BD-ROM-DL, BD-R, 
BD-R-DL, BD-RE, BD-RE-DL, 
DVD-ROM, DVD+R, 
DVD+R-DL, DVD+RW, DVD-R, 
DVD-R-DL, DVD-RW, 
DVD-RAM (Ver.2), CD-DA, 
CD-ROM (mode 1 and 
mode 2), CD-ROM XA 
(mode 2, form 1 and form 2), 
Photo CD (single and multiple 
sessions), CD Extra, CD-R, 
CD-RW, and CD-TEXT

DVD-RAM (Ver.2), DVD+R, 
DVD-R, CD-R, and CD-ROM

Access time BD DVD 

Random < 230 ms < 180 ms 

Cache buffer 4.5 MB 

Data transfer rate 

2X BD-RAM 9 MB/sec 

8X DVD 2,400 KB/sec 

16X CD-R 2,400 KB/sec 

16X CD-RW 2,400 KB/sec 
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Specifications
DVD±RW and CD-RW SuperMulti Double-Layer Drive specifications

Applicable disc Read: Write:

CD-DA, CD+(E)G, CD-MIDI, 
CD-TEXT, CD-ROM, 
CD-ROM XA, 
MIXED MODE CD, CD-I, 
CD-I Bridge (Photo-CD, 
Video CD), Multisession CD 
(Photo-CD, CD-EXTRA, 
Portfolio, CD-R, CD-RW), 
CD-R, CD-RW, DVD-ROM 
(DVD-5, DVD-9, DVD-10, 
DVD-18), DVD-R, DVD-RW, 
DVD+R, DVD+RW, 
and DVD-RAM

CD-R, CD-RW, DVD+R, 
DVD+RW, DVD-R, DVD-RW, 
and DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2.5 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8x DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA mode
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Specifications
DVD-ROM Drive specifications

Applicable disc Read: Write:

CD-DA, CD+(E)G, CD-MIDI, 
CD-TEXT, CD-ROM, 
CD-ROM XA, 
MIXED MODE CD, CD-I, 
CD-I Bridge (Photo-CD, 
Video CD), Multisession CD 
(Photo-CD, CDEXTRA, 
Portfolio, CD-R, CD-RW), CDR, 
CD-RW, DVD-ROM (DVD-5, 
DVD-9, DVD-10, DVD-18), 
DVD-R, DVD-RW, DVD+R, 
DVD+RW, DVD-RAM

CD-R and CD-RW

Access time CD DVD

Random < 110 ms < 130 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec
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Specifications
System DMA specifications

System memory map specifications

Hardware DMA System function 

DMA0 Not applicable 

DMA1* Not applicable 

DMA2* Not applicable 

DMA3 Not applicable 

DMA4 Direct memory access controller 

DMA5* Not applicable 

DMA6 Not assigned 

DMA7 Not assigned 

*ExpressCard controller can use DMA 1, 2, or 5. 

Size Memory address System function 

640 KB 00000000–0009FFFF Base memory 

128 KB 000A0000–000BFFFF Video memory 

64 KB 000C0000–000CFFFF Video BIOS 

64 KB 000E8000–000FFFFF System BIOS 

00100000–XFFFFFFF Extended memory (based on 
memory installed)

(X+1)0000000–FEDFFFFF PCI bus

FED00000–FED003FF High-precision event timer

FEE01000–FFFFFFFF PCI bus 
Maintenance and Service Guide 6–7



Specifications
System interrupt specifications

Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-key or Microsoft natural keyboard

IRQ8 System CMOS/real-time clock

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ16 Intel ICH9 family USB universal host controller 2937
Mobile Intel 4 Series express chipset family

IRQ17* High-definition audio controller
Intel ICH9 family USB universal host controller 2938 
Marvell Yukon 88E8072 PCIE-gigabit Ethernet controller

IRQ18 Intel ICH9 family USB universal host controller 2939
Intel ICH9 family USB universal host controller 2936

IRQ19 Intel ICH9 family USB2 enhanced controller 293C

IRQ20 Intel ICH9 family USB2 enhanced controller 293A
Intel ICH9 family USB universal host controller 2934

IRQ21 Intel ICH9M-E/M SATA AHCI controller

IRQ22 Intel ICH9 family USB universal host controller 2935

*Default configuration; other possible audio configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none. 

✎ ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial 
port may assert IRQ3 or IRQ4. 

✎ For operating systems after Windows 2000, APIC (Advanced programming interrupt controller) is used.
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Specifications
System I/O address specifications

I/O address (hex) System function (shipping configuration) 

000–01F DMA controller

020–021 Program interrupt controller

024–025 Program interrupt controller

028–029 Program interrupt controller

02C–03D Program interrupt controller

02E–02F Motherboard resources

030–031 Program interrupt controller

034–035 Program interrupt controller

038–039 Program interrupt controller

03C–03D Program interrupt controller

040–043 System timer

04E–04F Motherboard resources

050–053 System timer

060 Standard 101-/102-key or Microsoft natural keyboard

061 Motherboard resources

062 Microsoft ACPI-compliant embedded controller

063 Motherboard resources

064 Standard 101-/102-key or Microsoft natural keyboard

065 Motherboard resources

066 Microsoft ACPI-compliant embedded controller

067 Motherboard resources

070 Motherboard resources

071–077 System CMOS/real-time clock

080 Motherboard resources

081–091 Direct memory access controller

092 Motherboard resources

093–09F Direct memory access controller

0A0–0A1 Program interrupt controller

0A4–0A5 Program interrupt controller

0A8–0A9 Program interrupt controller

0AC–0AD Program interrupt controller

0B0–0B1 Program interrupt controller

0B2–0B3 Motherboard resources

0B4–0B5 Program interrupt controller

0B8–0B9 Program interrupt controller

0BC–0BD Program interrupt controller

(Continued)
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Specifications
0C0–0DF Direct memory access controller

0F0–0F0 Numeric data processor

0200–027F Motherboard resources

3B0–3BB Mobile Intel 4 Series express chipset family

3C0–3DF Mobile Intel 4 Series express chipset family

400–47F Motherboard resources

4D0–4D1 Programmable interrupt controller

500–57F Motherboard resources

1000–1003 Motherboard resources

1010–101F Motherboard resources

2000–20FF Marvell Yukon 88E8072 PCIE-gigabit Ethernet controller

2000–2FFF ICH9 family PCI express root port6-294A

3000–4FFF ICH9 family PCI express root port5-2948

5000–6FFF ICH9 family PCI express root port3-2944

7000–701F ICH9M-E/M SATA AHCI controller

7020–703F ICH9 family USB universal host controller 2936

7040–705F ICH9 family USB universal host controller 2935

7060–707F ICH9 family USB universal host controller 2934

7080–709F ICH9 family USB universal host controller 2939

70A0–70BF ICH9 family USB universal host controller 2938

70C0–70DF ICH9 family USB universal host controller 2937

70E0–70E7 ICH9M-E/M SATA AHCI controller

70E8–70EF ICH9M-E/M SATA AHCI Controller

70F0–70F7 Mobile Intel 4 Series express chipset family

70F8–70FB ICH9M-E/M SATA AHCI controller

70FC–70FF ICH9M-E/M SATA AHCI controller

EF80–EF9F Motherboard resources

FE00–FE0F Motherboard resources

FE80–EF8F Motherboard resources

FFFF Motherboard resources

I/O address (hex) System function (shipping configuration) 
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7
Screw listing

This chapter provides specification and reference information for the screws used in the computer. The screws 
listed in this chapter are available in the Screw Kit, spare part number 577213-001. 

Phillips PM2.0×6.0 captive screw

Where used:

1 Two captive screws that secure the hard drive cover to the computer (screws are secured to the cover by C-clips)

2 Two captive screws that secure the memory/wireless module compartment cover to the computer (screws are 
secured to the cover by C-clips)

Color Quantity Length Thread Head diameter 

Black 4 6.0 mm 2.0 mm 5.0 mm
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Screw listing
Phillips PM2.5×11.0 captive screw

 

Where used: One screw that secures the hard drive to the computer (screw is secured to the hard drive bracket)

Color Quantity Length Thread Head diameter 

Black 1 11.0 mm 2.5 mm 5.0 mm
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Screw listing
Phillips PM3.0×4.0 screw

 

Where used: 4 screws that secure the hard drive bracket to the hard drive

Color Quantity Length Thread Head diameter 

Silver 4 4.0 mm 3.0 mm 5.0 mm
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Screw listing
Phillips PM2.5×4.0 screw

Where used:

1 Two screws that secure the WLAN module to the computer

2 Two screws that secure the WWAN module to the computer

Where used: 4 screws that secure the display panel to the display enclosure

Color Quantity Length Thread Head diameter 

Black 8 4.0 mm 2.5 mm 5.0 mm
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Screw listing
Phillips PM2.5×8.0 screw

 

Where used: One screw that secures the optical drive to the computer

Color Quantity Length Thread Head diameter 

Black 1 8.0 mm 2.5 mm 5.0 mm
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Screw listing
Slotted Torx T8M2.5×7.0 screw

Where used:

1 Two screws that secure the switch cover to the computer

2 Two screws that secure the keyboard to the computer

Color Quantity Length Thread Head diameter 

Black 14 7.0 mm 2.5 mm 5.0 mm
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Screw listing
Where used: One screw that secures the palm rest to the computer

Where used: 4 screws that secure the top cover to the base enclosure

Where used: 5 screws that secure the top cover to the base enclosure
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Screw listing
Torx T8M2.5×6.0 screw

Where used: 5 screws that secure the display assembly to the computer

Color Quantity Length Thread Head diameter 

Black 12 6.0 mm 2.5 mm 5.0 mm
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Screw listing
Where used: 4 screws that secure the display bezel to the display assembly

Where used: One screw that secures the top cover to the base enclosure

Where used: 2 screws that secure the system board to the base enclosure
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Screw listing
Phillips PM2.0×4.0 screw

 

Where used: 3 screws that secure the optical drive bracket to the optical drive

Color Quantity Length Thread Head diameter 

Black 13 4.0 mm 2.0 mm 4.5 mm
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Screw listing
Where used: 4 screws that secure the speakers to the switch cover

Where used: 2 screws that secure the modem module to the system board

Where used: 4 screws that secure the fan to the heat sink
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Screw listing
Phillips PM2.0×5.0 screw

 

Where used: 2 screws that secure the switch cover to the computer in the battery bay

Color Quantity Length Thread Head diameter 

Black 2 5.0 mm 2.0 mm 4.5 mm
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Screw listing
Phillips PM2.0×2.0 broadhead screw

 

Where used: One screw that secures the switch cover to the computer in the battery bay

Color Quantity Length Thread Head diameter 

Black 1 2.0 mm 2.0 mm 6.0 mm
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Screw listing
Phillips PM2.0×3.0 screw

 

Where used: 6 screws that secure the display hinges to the display panel

Where used: 3 screws that secure the top cover to the base enclosure

Color Quantity Length Thread Head diameter 

Silver 9 3.0 mm 2.0 mm 4.5 mm
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Screw listing
Phillips PM2.0×9.0 captive screw

 

Where used: One captive screw that secures the fan and system board to the base enclosure (screw is secured to the 
fan by a C-clip)

Color Quantity Length Thread Head diameter 

Black 7 9.0 mm 2.0 mm 5.0 mm
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Screw listing
Where used: 6 captive screws that secure the fan and heat sink to the system board (screws are secured to the 
heat sink by C-clips)
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8
Backup and recovery

Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders, back up 
your entire hard drive (select models only), or create system restore points. In case of system failure, you can use 
the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

■ Backing up individual files and folders

■ Backing up the entire hard drive (select models only)

■ Scheduling automatic backups (select models only)

■ Creating system restore points

■ Recovering individual files

■ Restoring the computer to a previous state

■ Recovering information using recovery tools

✎ For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later use.
Maintenance and Service Guide 8–1



Backup and recovery
Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

■ Store personal files in the Documents folder, and back it up regularly.

■ Back up templates that are stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

d. Save the document.

■ When backing up to discs, use any of the following types of discs (purchased separately): CD-R, CD-RW, 
DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD-RW. The discs you use will depend on the type of optical 
drive installed in your computer.

✎DVDs and DVDs with double-layer (DL) support store more information than CDs, so using them for 
backup reduces the number of recovery discs required.

■ When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.
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Backup and recovery
Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools: You can use the Backup and Restore Center to recover information you have 
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent Windows 
from starting correctly.

■ f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The image 
includes the Windows operating system and software programs installed at the factory.

✎ If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system DVD to 
reboot the computer and repair the operating system. For additional information, refer to the “Using a Windows 
Vista operating system DVD (purchased separately)” section in this chapter.

Using the Windows recovery tools

To recover information you previously backed up, follow these steps:

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

✎Windows includes the User Account Control feature to improve the security of your computer. You may 
be prompted for your permission or password for tasks such as installing software, running utilities, or 
changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

Ä
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive. All files you have created 
and any software installed on the computer are permanently removed. When reformatting is complete, the recovery process 
restores the operating system, as well as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find the 
partitions, select Start > Computer.

✎ If the Windows partition and the HP Recovery partition have been deleted, you must recover your 
operating system and programs using the Windows Vista operating system DVD and the Driver 
Recovery disc (both purchased separately). For additional information, refer to the “Using a 
Windows Vista operating system DVD (purchased separately)” section in this chapter.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

✎ For additional information on recovering information using the Windows tools, perform a search for these topics 
in Help and Support.
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Backup and recovery
Using f11

Ä
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you have created and any 
software installed on the computer are permanently removed. The f11 recovery tool reinstalls the operating system and 
HP programs and drivers that were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select Start > 
Computer.

✎ If the HP Recovery partition has been deleted, you must recover your operating system and 
programs using the Windows Vista operating system DVD and the Driver Recovery disc (both 
purchased separately). For additional information, refer to the “Using a Windows Vista operating 
system DVD (purchased separately)” section in this chapter.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message 
is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system DVD to 
reboot the computer and repair the operating system. Make sure that your most recent backup (stored on discs or on 
an external drive) is easily accessible. To order a Windows Vista operating system DVD, go to 
http://www.hp.com/support, select your country or region, and follow the on-screen instructions. You can also order the 
DVD by calling technical support. For contact information, refer to the Worldwide Telephone Numbers booklet 
included with the computer.

Ä
CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and reformats the hard drive. 
All files you have created and any software installed on the computer are permanently removed. When reformatting is complete, 
the recovery process helps you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

✎ This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical drive before 
the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery
Backup and recovery in Windows XP

Overview

To protect your information, use the Windows Backup utility (select models only) to back up files and folders or 
create recovery points. In case of system failure, you can use the backup files to restore your computer.

Windows provides the following options:

■ Backing up individual files and folders

■ Backing up all files and folders

■ Scheduling automatic backups

■ Creating recovery points

■ Recovering information

✎ For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

■ Store personal files in the My Documents folder, and back it up periodically.

■ Back up templates stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.
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Backup and recovery
Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools (select models only): You can use the Windows Backup utility to recover information 
you have previously backed up.

■ Operating System and Driver Recovery discs (included with your computer): You can use the discs to recover 
your operating system and programs installed at the factory.

Recovering your information

To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Select Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

✎ For additional information on initiating a recovery in Windows, perform a search for this topic in 
Help and Support.

Recovering the operating system and programs

Ä
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have created and any software 
installed on the computer are permanently removed. The recovery process reinstalls the original operating system, software, and 
drivers. Software, drivers, and updates not installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the 
Driver Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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9
Connector pin assignments

Audio-in (microphone)

Audio-out (headphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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Connector pin assignments
External monitor

 
Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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Connector pin assignments
HDMI

Pin Signal

1 TMDS data 2+

2 TMDS data 2 shield

3 TMDS data 2-

4 TMDS data 1+

5 TMDS data 1 shield

6 TMDS data 1-

7 TMDS data 0+

8 TMDS data 0 shield

9 TMDS data 0-

10 TMDS clock+

11 TMDS clock shield

12 TMDS clock-

13 CEC

14 No connect

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect
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Connector pin assignments
RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

7 Unused

8 Unused
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Connector pin assignments
RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Connector pin assignments
Universal Serial Bus

 

Pin Signal

1 +5 VDC

2 Data

3 Data +

4 Ground
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10
Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to 120 volts AC, 
or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or region 
where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region where 
the computer is used.

Requirements for all countries and regions
The following requirements are applicable to all countries and regions:

■ The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

■ All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in the 
country or region where the power cord set will be used.

■ The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating of 125 or 
250 V AC, as required by the power system of each country or region.

■ The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of the computer.
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Power cord set requirements
Requirements for specific countries and regions

Country/region Accredited agency Applicable note number 

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese 
Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug must be a 
two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.
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11
Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household waste. 
Follow the local laws and regulations in your area for computer battery disposal.

Display

Å
WARNING: The backlight contains mercury. Caution must be exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

Ä
CAUTION: The procedures in this chapter can result in damage to display components. The only components intended for 
recycling purposes are the liquid crystal display (LCD) panel and the backlight. When you remove these components, handle 
them carefully.

✎ Materials Disposal. This HP product contains mercury in the backlight in the display assembly that might 
require special handling at end-of-life. Disposal of mercury may be regulated because of environmental 
considerations. For disposal or recycling information, contact your local authorities, or see the Electronic 
Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be 
disassembled to gain access to the backlight 1 and the liquid crystal display (LCD) panel 2.

✎ The procedures provided in this chapter are general disassembly instructions. Specific details, such as screw 
sizes, quantities, and locations, and component shapes and sizes, can vary from one computer model to another.
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Recycling
Perform the following steps to disassemble the display assembly:

1. Remove all screw covers 1 and screws 2 that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges 1 and the top and bottom inside edges 2 of the display bezel 
until the bezel disengages from the display assembly.

3. Remove the display bezel 3.
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Recycling
4. Disconnect all display panel cables 1 from the display inverter and remove the inverter 2.

5. Remove all screws 1 that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly 2 from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.
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Recycling
9. Use a sharp-edged tool to cut the tape 1 that secures the sides of the display panel to the display panel frame.

10. Remove the display panel frame 2 from the display panel.
 

11. Remove the screws 1 that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover 2 and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.

15. Remove the backlight cables 1 from the clip 2 in the display panel.
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Recycling
16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

Å
WARNING: The backlight contains mercury. Exercise caution when removing and handling the backlight to avoid damaging 
this component and causing exposure to the mercury.

18. Remove the backlight from the backlight frame.
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Recycling
19. Disconnect the display cable 1 from the LCD panel.

20. Remove the screws 2 that secure the LCD panel to the display rear panel.

21. Release the LCD panel 3 from the display rear panel.

22. Release the tape 4 that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter, spare part numbers 3–14, 3–15, 3–17
antennas

disconnecting 4–15, 4–17
locations 2–1
removal 4–34, 4–35
spare part number 4–34, 4–35

audio, product description 1–5
audio-in jack

connector pinout 9–1
location 2–7

audio-out jack
connector pinout 9–1
location 2–7

B
backing up files 8–2
Backup and Restore Center 8–1, 8–2
base enclosure, spare part number 3–6, 3–19
battery

removal 4–7
spare part numbers 3–6, 3–20, 4–7

battery bay 2–10
battery light 2–9
battery release latch 2–10
BIOS administrator password 5–4
Bluetooth module

removal 4–40
spare part number 3–4, 3–17, 4–40

Bluetooth module cable
illustrated 3–9
removal 4–41

Blu-ray ROM DVD±R/RW SuperMulti Double-Layer 
Drive

precautions 4–2
removal 4–18
spare part number 3–6, 3–13, 3–18, 4–18
specifications 6–4

boot options 5–5
boot order 5–5
bottom components 2–10
built-in device

Bluetooth device radio 5–6
microphone 5–6

modem 5–6
Network Interface Controller (LAN) 5–6
optical disc drive 5–6
wake on LAN 5–6
wireless button 5–6

built-in device options 5–6
buttons

Info Center/QuickLook 2–2
power 2–3
TouchPad 2–6
volume mute 2–2
wireless 2–2

C
Cable Kit

components 3–9
spare part number 3–5, 3–9, 3–19

cables, service considerations 4–1
caps lock light 2–5
Card 1–6
chipset, product description 1–2
components

bottom 2–10
buttons 2–2
display 2–1
fingerprint reader 2–2
front 2–7
keys 2–4
left-side 2–9
lights 2–5
pointing device 2–6
right-side 2–8
top 2–2

computer feet
locations 4–6
spare part number 4–6

Computer Setup
accessing 5–1
Diagnostics menu 5–5
File menu 5–3
navigating and selecting 5–1
restoring factory settings 5–2
Security menu 5–4
System Configuration menu 5–5
using 5–1
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Index
computer specifications 6–1
connector pinout

audio-in jack 9–1
audio-out jack 9–1
external monitor port 9–2
HDMI port 9–3
headphone jack 9–1
microphone jack 9–1
modem jack 9–4
monitor port 9–2
network jack 9–5
RJ-11 jack 9–4
RJ-45 jack 9–5
USB port 9–6

connectors, service considerations 4–1
creating a backup 8–2

D
device configurations 5–5, 5–6
Diagnostics menu 5–5
Disk Sanitizer 5–4
diskette drive, product description 1–4
display assembly

removal 4–27
spare part numbers 3–3, 3–17, 3–18, 3–20, 4–27

display bezel
illustrated 3–11
removal 4–30
spare part numbers 3–11, 3–18, 4–31

Display Cable Kit
illustrated 3–11
spare part numbers 3–11, 3–20

display components
illustrated 2–1
recycling 11–1
spare part numbers 3–10

display enclosure
illustrated 3–11
spare part numbers 3–11, 3–18

display hinges
illustrated 3–11
removal 4–32
spare part number 3–11, 3–18

display inverter, removal 11–3
display panel

product description 1–2
removal 4–31

display panel cable
illustrated 3–11
removal 4–33
spare part numbers 3–11, 3–18, 3–20, 4–33

display switch 2–1
drive light 2–7
DriveLock password 5–4
DriveLock, automatic 5–4
drives, boot order 5–5
DVD±RW and CD-RW SuperMulti Double-Layer 

Drive
precautions 4–2
removal 4–18
spare part number 3–6, 3–13, 3–18, 4–18
specifications 6–5

DVD-ROM Drive
precautions 4–2
removal 4–18
spare part number 3–6, 3–13, 3–18, 4–18
specifications 6–6

E
electrostatic discharge 4–2
equipment guidelines 4–4
esc key 2–4
Ethernet, product description 1–5
ExpressCard slot 2–8
ExpressCard slot bezel

illustrated 3–12
removal 4–38

external media card, product description 1–6
external monitor port

connector pinout 9–2
location 2–8

F
f11 recovery 8–4
fan

removal 4–51
spare part number 3–6, 3–19, 4–51

feet
locations 4–6
spare part number 4–6

File menu 5–3
fingerprint reader 2–3
fn key 2–4
front components 2–7
function keys 2–4

G
graphics, product description 1–2
grounding equipment and methods 4–2

H
hard disk test 5–5
hard drive

precautions 4–2
product description 1–4
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Index
removal 4–9
spare part numbers 3–6, 3–13, 3–18, 3–20, 4–9
specifications 6–3

hard drive bay 2–10
hard drive bracket, removal 4–11
hard drive connector, removal 4–11
hard drive cover

illustrated 3–12
removal 4–10

hard drive recovery 8–4
HDMI port

connector pinout 9–3
location 2–8

headphone jack
connector pinout 9–1
location 2–7

heat sink
removal 4–51
spare part numbers 3–6, 3–20, 4–51

hinges
illustrated 3–11
removal 4–32
spare part number 3–11, 3–18

HP SpareKey Enrollment 5–4

I
Info Center/QuickLook button 2–2
Info Center/QuickLook light 2–5

J
jacks

audio-in 2–7
audio-out 2–7
headphone 2–7
microphone 2–7
modem 2–9
network 2–8
RJ-11 2–9
RJ-45 2–8

K
key components 2–4
keyboard

product description 1–6
removal 4–20
spare part numbers 3–3, 3–4, 3–18, 3–19, 4–20

keys
esc 2–4
fn 2–4
function 2–4
numeric keypad 2–4
Windows applications 2–4
Windows logo 2–4

L
language, changing in Computer Setup 5–5
left-side components 2–9
legacy support, USB 5–1, 5–5
light components 2–5
lights

battery 2–9
caps lock 2–5
drive 2–7
Info Center/QuickLook 2–5
power 2–5
volume down 2–5
volume mute 2–5
volume up 2–5
webcam 2–1
wireless 2–5

M
mass storage devices, spare part numbers 3–13
memory module

removal 4–16
spare part numbers 3–6, 4–16

memory module compartment 2–10
memory, product description 1–3
memory/wireless module compartment cover

illustrated 3–12
removal 4–14

microphone
locations 2–1
product description 1–4
removal 4–33

microphone jack
connector pinout 9–1
location 2–7

model name 3–1, 4–5
modem jack

connector pinout 9–4
location 2–9

modem module
removal 4–42
spare part numbers 3–5, 3–17, 4–42

modem module cable
illustrated 3–9
removal 4–44

modem, product description 1–5
monitor port

connector pinout 9–2
location 2–8

N
network cable

illustrated 3–9
removal 4–50
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network jack
connector pinout 9–5
location 2–8

numeric keypad keys 2–4

O
operating system, product description 1–7, 1–8
optical drive

location 2–9
precautions 4–2
product description 1–4
removal 4–18
spare part numbers 3–6, 3–13, 3–18, 4–18
specifications 6–4, 6–5, 6–6

optical drive bracket, removal 4–19
optical drive slot bezel, illustrated 3–12

P
packing guidelines 4–3
palm rest, removal 4–25
passwords 5–4
plastic parts 4–1
Plastics Kit

components 3–12
contents 3–12
spare part number 3–4, 3–12, 3–19

pointing device
components 2–6
illustrated 2–6
product description 1–6

port options
ExpressCard slot 5–6
flash media reader 5–6
USB port 5–6

ports
external monitor 2–8
HDMI 2–8
monitor 2–8
product description 1–6
USB 2–8, 2–9

power button 2–3
power button board

removal 4–46
spare part numbers 3–5, 3–20, 4–46

power connector 2–9
power connector cable

illustrated 3–9
removal 4–45

power cord
set requirements 10–1
spare part numbers 3–14, 3–15

power light 2–5
power requirements, product description 1–6

processor
product description 1–1
removal 4–55
spare part numbers 3–6, 3–16, 3–17, 4–55

product description
audio 1–5
chipset 1–2
diskette drive 1–4
display panel 1–2
Ethernet 1–5
external media card 1–6
graphics 1–2
hard drive 1–4
keyboard 1–6
memory 1–3
microphone 1–4
modem 1–5
operating system 1–7, 1–8
optical drive 1–4
pointing device 1–6
ports 1–6
power requirements 1–6
processor 1–1
security 1–6
serviceability 1–8
webcam 1–5
wireless 1–5

product name 1–1, 3–1, 4–5

R
recovering information 8–3
recovery partition 8–3
recovery, system 8–1
recycling

battery 11–1
display components 11–1

removal/replacement
preliminaries 4–1
procedures 4–5

restoring factory settings 5–2, 5–3
restoring security defaults 5–6
restoring the hard drive 8–2
right-side components 2–8
RJ-11 jack

connector pinout 9–4
location 2–9

RJ-45 jack
connector pinout 9–5
location 2–8

RTC battery
removal 4–54
spare part number 3–5, 3–20, 4–54
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Rubber Feet Kit, spare part number 3–6, 3–19, 4–6
run-in test 5–5

S
SATA (Serial Advanced Technology Attachment) 

devices
AHCI (Advanced Host Controller Interface) 5–6
IDE (Integrated Drive Electronics) 5–6

Screw Kit, spare part number 3–14, 3–19
screw listing 7–1
SD Card Reader 2–7
SD Card Reader slot bezel

illustrated 3–4, 3–12
removal 4–48

security cable slot 2–8
Security menu 5–4

allow reset of HP ProtectTools security keys 5–4
always prompt for HP SpareKey enrollment 5–4
Automatic DriveLock 5–4
change password 5–4
Disk Sanitizer 5–4
DriveLock 5–4
HP SpareKey 5–4
HP SpareKey enrollment 5–4
password policy 5–4
set up BIOS administrator password 5–4
System IDs 5–4
user management 5–4

security, product description 1–6
service considerations 4–1
serviceability, product description 1–8
set security level 5–6
SIM slot 2–10
SIM, removal 4–8
speakers

location 2–2
removal 4–24
spare part number 3–3, 3–19, 4–24

specifications
Blu-ray ROM DVD±R/RW SuperMulti 

Double-Layer Drive 6–4
computer 6–1
display assembly 6–2
DVD±RW and CD-RW SuperMulti Double-Layer 

Drive 6–5
DVD-ROM Drive 6–6
hard drive 6–3
optical drive 6–4, 6–5, 6–6
system DMA 6–7
system I/O address 6–9
system interrupt 6–8
system memory map 6–7

switch cover
removal 4–20
spare part numbers 3–3, 3–19, 4–20

system board
removal 4–47
spare part numbers 3–5, 3–20, 4–47

System Configuration menu 5–5
system DMA specifications 6–7
system fan 5–5
system I/O address specifications 6–9
system IDs 5–4
system information 5–5
system interrupt specifications 6–8
system memory map specifications 6–7
system recovery 8–1

T
tools required 4–1
top components 2–2
top cover

removal 4–36
spare part numbers 3–4, 3–19, 3–20, 4–36

TouchPad 2–6
TouchPad buttons 2–6
TouchPad scroll zone 2–6

U
Universal Serial Bus (USB) port

connector pinout 9–6
location 2–8, 2–9

USB board
removal 4–39
spare part number 3–5, 3–20, 4–39

USB legacy support 5–1, 5–5

V
vents 2–8, 2–10
volume down light 2–5
volume mute button 2–2
volume mute light 2–5
volume scroll zone 2–2
volume up light 2–5

W
warranty period 3–1, 4–5
webcam 2–1
webcam light 2–1
webcam module

illustrated 3–11
removal 4–31
spare part number 3–11, 3–17, 4–32

webcam, product description 1–5
Windows applications key 2–4
Windows logo key 2–4
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Windows Vista operating system DVD 8–3
wireless antennas

disconnecting 4–15, 4–17
locations 2–1
removal 4–34, 4–35
spare part number 4–34, 4–35

wireless button 2–2
wireless light 2–5
wireless, product description 1–5
WLAN module

removal 4–12
spare part numbers 3–7, 3–8, 3–15, 3–16, 4–12

workstation guidelines 4–4
WWAN module

removal 4–17
spare part numbers 3–8, 3–15, 3–17, 3–20, 4–17
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